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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your Xerox 
printer. 
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Notices and Safety 

Please read the following instructions carefully before operating your printer. Refer to these instructions 
to ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These 
include safety agency evaluation and certification, and compliance with electromagnetic regulations 
and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 

Note: Unauthorized alterations, which can include the addition of new functions or connection of 
external devices, can affect the product certification. Please contact your Xerox representative for 
more information. 
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Electrical Safety 

This section includes: 
• General Guidelines ........................................................................................................................................................... 11 
• Power Cord ......................................................................................................................................................................... 12 
• Emergency Turn Off ........................................................................................................................................................ 12 
 

General Guidelines 
 

 WARNINGS: 

• Do not push objects into slots or openings on the printer. Touching a voltage point or shorting 
out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Turn off the printer when performing these 
installations. Disconnect the power cord when removing covers and guards for installing optional 
equipment. Except for user-installable options, there are no parts that you can maintain or 
service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Turn off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
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Power Cord 

Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

 

 WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power 
plugs for more than 90 days. When a permanent outlet receptacle cannot be installed, use only one 
factory-assembled extension cord of the appropriate gauge per printer or multifunction printer. 
Always adhere to national and local building, fire, and electrical codes regarding length of cord, 
conductor size, grounding, and protection. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Do not plug or unplug the power cord while the power switch is in the On position. 
• If the power cord becomes frayed or worn, replace it. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Emergency Turn Off 

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord 
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 
• Do not remove any trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer while is printing. 
• Keep hands, hair, neckties, and so on away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
• Do not override any electrical or mechanical interlock devices. 
• Do not attempt to remove paper that is jammed deeply inside the product. Switch off the product 

promptly and contact your local Xerox representative. 
 

 WARNING: The metallic surfaces in the fuser area are hot. Always use caution when removing paper 
jams from this area and avoid touching any metallic surfaces. 

 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=environmenteu&Language=English
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Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, see Physical Specifications on page 167. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation on page 168. 
 

Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

• Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 

• Clean with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 

recycling programs, go to www.xerox.com/gwa. 

 WARNING: 

Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on 
electromechanical equipment. 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=recyclesupplies&Language=English
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a hazard which, if not avoided, could result in death or serious injury. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Do not burn the item. 

 

Do not expose the imaging unit to light for more than 10 minutes. 

 

Do not expose the imaging unit to direct sunlight. 

 

Do not touch the part or area of the printer. 

 

 

Warning: 
Wait for the printer to cool for the specified time before touching the fuser. 

 

This item can be recycled. For details, see Recycling and Disposal on page 183. 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 

Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=environmenteu&Language=English
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Parts of the Printer 

This section includes: 
• Front View ........................................................................................................................................................................... 20 
• Rear View ............................................................................................................................................................................ 21 
• Control Panel ..................................................................................................................................................................... 21 
 

Front View 

 
 

1. Output Tray Extension 
2. Output Tray 
3. Control Panel 
4. Document Cover 
5. Side Door 
6. Document Glass 
7. Cleaning Rod 

8. Power Switch 
9. Paper Tray 
10. Width Guides 
11. Slide Bar 
12. Length Guide 
13. USB Memory Port 
14. Bypass Tray 
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Rear View 

 
 

1. USB Port 
2. Rear Door Release Button 
3. Power Connector 

4. Rear Door 
5. Transfer Roller 
6. Fuser Roller Release Levers 

 
 

Control Panel 

The control panel consists of a display, indicator lights, and buttons you can press to control the 
functions available on the printer. 

The control panel provides the following: 
• Current operating status of the printer 
• Access to copy, print, and scan features 
• Access to information pages 
• Prompts you to load paper, replace supplies, and clear jams 
• Displays errors and warnings 
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Control Panel Buttons and Indicators 

 
 

Item Display/Panel 
Symbol 

Name Description 

1 

 

Wi-Fi Light This light indicates that a wireless connection is 
established between the printer and the wireless router. 

2 

 

WPS Button To establish a wireless connection, first, press the button 
on the printer, then press the button on your wireless 
router. 

3 

 

Copy Button This button provides access to the Copy menu. 

4 

 

ID Card Copy Button This button provides access to the ID Card Copy menu. 

5 

  

Up and Down Arrow 
Buttons 

To navigate to the next menu, item, or option, press these 
buttons. 

6 

  

Left and Right Arrow 
Buttons 

To navigate forward and backward through submenus and 
fields, press these buttons. 

7 

 

Job Status Button This button displays a list of active or completed jobs. 

8 

 

System Button This button switches the display to the System menus. 

9  Alphanumeric Keypad Use these buttons to enter alpha or numeric characters as 
needed. 

10 

 

Clear All Button This button clears all current settings for printing, copying, 
or scanning and restores them to the default settings. 

11 

 

Power Saver button  This button illuminates when the printer is in Power Saver 
mode. Pressing this button causes the printer to exit Power 
Saver mode. 

12 

 

Stop Button This button cancels the current job. 
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Item Display/Panel 
Symbol 

Name Description 

13 

 

Start Button This button starts a copy or scan job. 

14 

 

Error Light This light indicates an error condition or warning that 
requires your attention. 

15 

 

Ready/Data Light The light appears green when the printer is ready to 
receive data, and blinks when the printer is busy receiving 
data. 

16  C (clear) Button This button deletes numeric values or the last digit entered 
using the alphanumeric keys. 

17 

 

Address Book This button provides access to the address book. This 
button activates when you access the Scan to E-Mail menu 
only. 

18 

 

OK Button This button displays the selected menu or selects the 
current menu option. 

19 

 

Back/Return Button Use this button to navigate to the previous menu item. 

20  Display Screen This screen displays status messages, menus, and toner 
levels. 

21 

 

Scan Button This button provides access to the Scan menu. 

22 

 

Print Button This button provides access to the Print menu. 

23  Color Mode Button Press the Color Mode button to toggle the selection 
between color and black and white. 

24  Color Mode Lights These lights indicate which color mode is selected. 
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Information Pages 

Your printer has a printable set of information pages. These pages include configuration, panel settings, 
error history, and more. 
 

Printing the Printer Information Pages from Your Computer 

You can use the Xerox® Office Printing utility included on your installation CD to print the following: 
• Configuration Page 
• Panel Settings 
• Job History 
• Error History 
• Demonstration Page 

To print information pages: 

Note: The following procedure is for Windows 7. 

1. Click Start > All Programs > Xerox Office Printing > WorkCentre 6025 > Printer Settings Utility. 
2. Click the Printer Settings Report tab. 
3. Click Information Pages. 
4. Select the page that you want to print. 
 

Printing the Printer Information Pages from the Control Panel 
1. On the printer control panel, press the System button. 
2. Navigate to Information Pages, then press OK. 
3. Navigate to the desired report, then press OK. 
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Power Saver Mode 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower 
power level. 

There are two levels of Power Saver mode. 
• Mode 1 (Low Power): The printer shifts from Ready mode to Low Power mode to reduce standby 

power consumption. 
• Mode 2 (Sleep): The printer shifts from Low Power mode to Sleep mode for a greater reduction in 

power consumption. 
 

Changing Power Saver Mode Settings from the Control Panel 
1. On the printer control panel, press the System button. 
2. Use the Up and Down arrows to navigate to Admin Menu, then press OK. 
3. Navigate to System Setup, then press OK. 
4. At Power Saver Timer, press OK. 
5. Select the Power Saver Mode you want to change, then press OK. 
6. To select the desired time, press the arrow buttons, or enter a value using the numeric keypad. 

− Power Saver Mode 1 (Low Power): Set the timer from 1–60 minutes. 
− Power Saver Mode 2 (Sleep): Set the timer from 1–60 minutes. 

7. Press OK. 
 

Exiting Power Saver Mode 

The printer exits Power Saver mode automatically when it receives data from a connected device. 

To exit Power Saver mode manually, on the control panel, press the Power Saver button. 
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Administrative Features 

Changing the Panel Lock Password 

The Panel Lock password limits access to the Admin menu. 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Enter the current four-digit password, then press OK. 
4. Select Secure Settings, then press OK. 
5. At Panel Lock, press OK. 
6. Select Change Password, then press OK. 
7. Enter a new four-digit password, then press OK. The default password is 0000. 
 

Printer Usage Information 

The Billing Meters menu shows the number of processed print jobs. You cannot reset the meter readings; 
they track the total number of pages printed for the life of the printer. 

There is a meter for each color mode. 

To view the meter readings: 
1. On the printer control panel, press the System button. 
2. Press the arrow buttons to select Billing Meters. 
3. Press OK. 
 

Meter Number Display Number 

Meter 1 The total number of pages printed in color. 

Meter 2 The total number of pages printed in black and white. 

Meter 3 This usage meter always displays 0. 

Meter 4 The total number of pages printed. 
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CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled on the printer. 
• A network-connected computer with a Web browser. 
 

Accessing CentreWare Internet Services 

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press 
Enter or Return. 
 

Finding the IP Address of Your Printer 

You can view the IP address of your printer on the Configuration Page. 
 

Logging In to CentreWare Internet Services 

When Administrator Mode is enabled, the Jobs, Address Book, Properties, and Support tabs are locked 
until you enter the administrator user name and password. 

To log in to CentreWare Internet Services as the administrator: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. Click the Jobs, Address Book, Properties, or Support tab. 
3. Type the administrator user name. 
4. Type your password, then click Login. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/WC6025docs 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

www.xerox.com/office/WC6025support 

Information about menus or error messages Press the control panel Help (?) button. 

Information Pages Print from the control panel, or from CentreWare 
Internet Services, click Status > Information Pages. 

CentreWare Internet Services documentation In CentreWare Internet Services, click Help. 

Order supplies for your printer www.xerox.com/office/WC6025supplies 

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=reg&Language=English
http://www.direct.xerox.com/
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This chapter includes: 
• Installation and Setup Overview ................................................................................................................................ 30 
• Selecting a Location for the Printer........................................................................................................................... 31 
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• Installing the Software .................................................................................................................................................. 38 
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• Configuring General Settings Using CentreWare Internet Services ............................................................. 47 
• Configuring General Setup Using the Control Panel .......................................................................................... 49 
• Configuring Security Settings Using CentreWare Internet Services ............................................................. 53 
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• Setting Up Scanning ....................................................................................................................................................... 59 
• Installing the Printer as a Web Services Device .................................................................................................... 65 
 

See also: 
Installation Guide packaged with your printer. 
Online Support Assistant at www.xerox.com/office/WC6025support 
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the print driver software and utilities on your computer. 

You can connect to your printer directly from your computer using a USB cable or a wireless network 
connection. 

Note: If the Software and Documentation disc is not available, you can download the latest drivers 
from www.xerox.com/office/WC6025drivers. 

 

See also: 
Selecting a Location for the Printer on page 31 
Choosing a Connection Method on page 32 
Connecting the Printer on page 32 
Configuring Network Settings on page 43 
Installing the Software on page 38 
 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=driver&Language=English
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Selecting a Location for the Printer 

1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 15–85%. 
 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the 
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the 
weight for your printer configuration, see Physical Specifications on page 167. 

After positioning the printer, you are ready to connect it to the power source and computer or network. 
 

See also: 
Total Space Requirements on page 167 
Clearance Requirements on page 167 
 

 



Installation and Setup 

 

32 Xerox® WorkCentre® 6025 Multifunction Printer 
 User Guide 
 

Connecting the Printer 

This section includes: 
• Selecting a Connection Method ................................................................................................................................. 32 
• Connecting to a Computer Using USB ..................................................................................................................... 33 
• Connecting to a Wireless Network ............................................................................................................................ 34 
• Connecting to Wi-Fi Direct ........................................................................................................................................... 37 
• Disabling Wireless Networking from the Control Panel .................................................................................... 37 
 

Selecting a Connection Method 

You can connect to your printer directly from your computer using a USB cable or Wi-Fi Direct, or over a 
wireless network using WPS. A USB connection is a direct connection and is the easiest to set up. A 
wireless connection is used for networking. If you are using a network connection, it is important to 
understand how your computer is connected to the network. For details, see About TCP/IP and IP 
Addresses on page 43. 

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network 
hubs, network switches, and modems are not included with your printer and must be purchased 
separately. 
• Wireless Network: If your computer includes a wireless router or wireless access point, you can 

connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network 
connection is typically faster than USB and allows direct access to the setting of the printer using 
CentreWare Internet Services. 

• USB: If you connect the printer to one computer and do not have a network, you can use a USB 
connection. 

Note: A USB connection does not provide access to CentreWare Internet Services. 

• Wi-Fi Direct: You can connect to the printer with a Wi-Fi mobile device using Wi-Fi Direct. Xerox 
recommends that only one user at a time accesses the printer using Wi-Fi Direct. 
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Connecting to a Computer Using USB 

To use USB, you must have Windows XP SP1 and later, Windows Server 2003 and later, or Macintosh OS 
X version 10.5 and later. 

Note: A USB cable is provided with your printer. 

To connect the printer to the computer using a USB cable: 
1. Ensure that the printer is turned off. 
2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the printer. 
3. Attach the power cord to the printer, plug the cord into an electrical outlet, then turn on the printer. 
4. Connect the A end of the USB cable to the USB port on the computer. 
5. If the Windows Found New Hardware Wizard appears, cancel it. 
6. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

7. Click Setup Printer and Install Software. 
8. At the License Agreement, select I Agree, then click Next. 
9. Click USB. 
10. To connect your printer and install the print driver and software, select Personal Installation, then 

click Next. 
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Connecting to a Wireless Network 

You can connect to a wireless network using the Software and Documentation disc included with your 
printer or from the printer control panel. 

Notes: 

• You can connect using the 3-click connection method one time on the first installation attempt 
only. 

• WPA2 Enterprise networks are not supported. 
• The 3-click connection method is supported for Windows 7 and later only. 

 

Connecting with 3-Click Connection 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Setup Printer and Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. On the Select a Connection Method screen, click Wireless. If a wireless connection is established, the 

Xerox Printer Found screen appears. 
5. To connect to the wireless network, click Next, or click Connect to a different wireless network. 
6. To complete the installation, click Finish. 

Note: If a connection is not established, select Search for Networks or WPS. For details, see Searching 
for Networks on page 35 or Connecting Using WPS on page 35. 
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Connecting Using Wi-Fi Protected Setup (WPS) 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Setup Printer and Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. On the Select a Connection Method screen, click Wireless. 
5. Click WPS. 
6. At the prompt, press and hold the WPS button on the printer for two seconds. 
7. After you press the WPS button on the printer, within two minutes, press and hold the WPS button 

on your wireless router for two seconds. 
8. After you press both buttons, click Next. 
9. In the printer list, select your printer. 

Note: You can name your printer and choose to share it on the network or set it as your default 
printer. 

10. In the Software and Documentation window, clear the check box for any undesired options. 
11. Click Next. 
12. To complete the installation, click Finish. 
 

Connecting Using Searching for Networks 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the 

installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer 
file. 

2. Click Setup Printer and Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. On the Select a Connection Method screen, click Wireless. 
5. On the Select a Wireless Setup Method screen, click Search for Networks. 
6. Ensure that the USB cable is connected properly. 
7. Select a network, then click Next. 
8. Enter the passphrase for your wireless network, then click Next. 
9. On the Configure Printer screen, click Next, or to configure IP settings manually, click Advanced. 
10. At the prompt, remove the USB cable from the printer, then click Next. 
11. In the printer list, select your printer. 

Note: You can name your printer and choose to share it on the network or set it as your default 
printer. 

12. Select Install printer driver, then click Next. 
13. In the Software and Documentation window, clear the check box for any undesired options. 
14. Click Next. 
15. To complete the installation, click Finish. 
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Connecting to a Wireless Network from the Control Panel 

You can connect your printer directly to a wireless network from the printer control panel. You do not 
require a computer to connect your printer to the network. 

To connect using automatic SSID setup: 
1. On the printer control panel, press the System button. 
2. Use the Up and Down arrows to navigate to Admin Menu, then press OK. 
3. Navigate to Network, then press OK. 
4. Navigate to Wireless Setup, then press OK. 
5. Select the desired network, then press OK. 
6. Enter the passcode or WEP key, then press OK. 

To connect using manual SSID setup: 
1. On the printer control panel, press the System button. 
2. Use the Up and Down arrows to navigate to Admin Menu, then press OK. 
3. Navigate to Network, then press OK. 
4. Navigate to Wireless Setup, then press OK. 
5. Navigate to Manual Setup, then press OK. 
6. Enter the network SSID, then press OK. 
7. For Network Mode, select an option, then press OK. 
8. Enter the passcode or WEP key, then press OK. 
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Connecting to Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. 

Note: Wi-Fi Direct is disabled by default. 
 

Connecting with Wi-Fi Direct from Your Mobile Device 

To connect with Wi-Fi Direct, follow the directions provided with your mobile device. 
 

Disabling Wireless Networking from the Control Panel 

You can disable the wireless network from the printer control panel. 

To disable wireless networking from the Control Panel: 
1. At the printer control panel, press the System button. 
2. To navigate to the Admin menu, use the Up and Down arrows, then press OK. 
3. Navigate to Network, then press OK. 
4. Navigate to Wi-Fi, then press OK. 
5. Select Off, then press OK. 
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Installing the Software 

This section includes: 
• Operating System Requirements ............................................................................................................................... 38 
• Installing the Print Drivers for a Windows Network Printer ............................................................................. 39 
• Installing the Print Drivers for a Windows USB Printer ...................................................................................... 39 
• Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later ...................................... 40 
• Installing Scan Drivers for Macintosh ...................................................................................................................... 42 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If 
you cannot find the IP address, see Finding the IP Address of Your Printer on page 27. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/WC6025drivers. 
 

Operating System Requirements 
• Windows XP SP3, Windows Vista, Windows 7, Windows 8, Windows Server 2003, Windows 

Server 2008, Windows Server 2008 R2, and Windows Server 2012. 
• Macintosh OS X version 10.5 and later 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=driver&Language=English
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Installing the Print Drivers for a Windows Network Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the 

installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer 
file. 

2. Click Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. Select Network Installation, then click Next. 
5. From the list of discovered printers, select your printer, then click Next. 

Notes: 

• When installing drivers for a network printer, if you do not see your printer in the list, click the 
IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of 
your printer, then click Search to locate your printer. If you do not know the IP address of the 
printer, see Finding the IP Address of Your Printer on page 27. 

• To enable continued use of the printer even if the IP Address assigned by the DHCP server 
changes, you can use the installer or CentreWare Internet Services. 

6. In the printer list, select your printer. 

Note: You can name your printer and choose to share it on the network or set it as your default 
printer. 

7. Click Next. 
8. In the Software and Documentation window, clear the check box for any undesired options. 
9. Click Next. 
10. To complete the installation, click Finish. 
 

Installing the Print Drivers for a Windows USB Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. To install the printer support software, select Software, then click Next. 
5. In the Software and Documentation window, clear the check box for any undesired options. 
6. Click Next. 
7. To complete the installation, click Finish. 
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Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later 

This section includes: 
• Installing the Print Driver .............................................................................................................................................. 40 
• Adding the Printer ............................................................................................................................................................ 41 
• Utilities ................................................................................................................................................................................. 41 

To access all features of the printer, you must: 
1. Install the print driver. 
2. Add the printer. 

Note: Before you install the print driver, verify that the printer is plugged in, turned on, and 
connected to an active network or by USB. 

 

Installing the Print Driver 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

Note: If the Software and Documentation disc is not available, you can download the latest drivers 
from www.xerox.com/office/WC6025drivers. 

2. Double-click WorkCentre 6025 Installer. 
3. At the Introduction installer window, click Continue. 
4. At the License Agreement, select I Agree, then click Next. 
5. Select the destination disk, then click Continue. 
6. To change the location of the driver installation, click Change Install Location. 
7. Click Install. 
8. If prompted, enter your password, then click OK. 
9. Click Continue Installation. 
10. To complete the installation and restart your computer, when the print driver finishes installing, click 

Restart. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=driver&Language=English
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Adding the Printer 

For networking, set up your printer using Bonjour (Rendezvous), or connect using the IP address of your 
printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection. 

To add the printer using Bonjour: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Print & Fax. 

The list of printers appears on the left of the window. 
3. Click the plus button (+) under the list of printers. 
4. Click the Default icon at the top of the window. 
5. Select your printer from the list and click Add. 
 

Note: If your printer was not detected, verify that the printer is on and that the Ethernet or USB 
cable is connected properly. 

 

To add the printer by specifying the IP address: 
1. From the computer Applications folder or from the dock, open System Preferences. 
2. Click Print & Fax. 

The list of printers appears on the left of the window. 
3. Click the plus button (+) under the list of printers. 
4. Click IP. 
5. From the Protocol drop-down menu, select the protocol. 
6. In the Address field, enter the IP address of the printer. 
7. In the Name field, enter a name for the printer. 
8. From the Print Using drop-down list, choose Select a driver to use. 
9. Select the print driver for your printer model from the list. 
10. Click Add. 

Now you can print and scan. For details, see Printing on page 83 and Scanning on page 107. 
 

See also: 
Online Support Assistant at: www.xerox.com/office/WC6025support 
 
 

Utilities 

The Address Book Editor and Express Scan Manager are installed automatically when you install the scan 
driver. For details, see Installing the Drivers and Utilities for Macintosh OS X Version 10.5 and Later on 
page 40. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
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Installing Scan Drivers for Macintosh 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. To view the .dmg file for your printer, double-click the disc icon on your desktop. 
3. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating 

system. 
4. Open the Scan Installer package file. 
5. To acknowledge the warning and introductory messages, click Continue. 
6. To accept the license agreement, click Continue, then click Agree. 
7. Click Continue again. 
8. Enter your password, then click OK. 
9. If prompted to close other installations, click Continue Installing. 
10. To restart, click Log Out. 
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Configuring Network Settings 

This section includes: 
• About TCP/IP and IP Addresses ................................................................................................................................. 43 
• Assigning the IP Address of the Printer ................................................................................................................... 43 
• Enabling the Printer for Scanning .............................................................................................................................. 46 
 

About TCP/IP and IP Addresses 

Computers and printers use TCP/IP protocols to communicate over a network. Macintosh computers use 
either TCP/IP or the Bonjour protocol to communicate with a network printer. For Macintosh OS X 
systems, TCP/IP is preferred. 

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks as well 
as cable and DSL routers have a DHCP server. A DHCP server assigns an IP address to every computer 
and printer on the network that is configured to use DHCP, automatically. 

If you are connected to the Internet using cable or DSL, check with your carrier for information on IP 
addressing. 
 

Assigning the IP Address of the Printer 

By default, the printer receives an IP address from a DHCP server over a TCP/IP network. Network 
addresses assigned by DHCP are temporary. Once the addresses expire, the network can assign a new 
one. 

To assign a static IP address for your printer, you can use the wireless connection method on the installer 
disk. 

Notes: 

• You can view the IP address of your printer on the Configuration Page. 
• To enable continued use of the printer even if the IP Address assigned by the DHCP server 

changes, you can use the installer or CentreWare Internet Services. 
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Assigning the IP Address Automatically 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. At Network, press OK. 
4. To select TCP/IP, press the Down Arrow button, then press OK. 
5. To select IPv4, press the arrow buttons, then press OK. 
6. At Get IP Address, press OK. 
7. To select DHCP/AutoIP, press the arrow buttons, then press OK. 
8. To return to the Ready screen, press Return. 
 

Assigning the IP Address Manually 

You can assign a static IP address to your printer from the printer control panel. Once an IP address is 
assigned, you can change it using CentreWare Internet Services. 

To assign a static IP address to the printer, you need the following information: 
• An IP address properly configured for your network 
• The Network Mask address 
• The default Router/Gateway address 

If you are on a network managed by a network administrator, contact your network administrator to 
obtain the network information. 

For a home network using routers or other devices to connect the printer to the network, refer to the 
device instructions on assigning network addresses. The router or device documentation can give you a 
range of acceptable address numbers you can use. It is important that the addresses be similar to the IP 
addresses used by other printers and computers on the network, but not the same. Only the last digit 
must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer 
has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4. 

The router could assign the static IP address of the printer to another computer that obtains its IP 
address dynamically. To avoid having the IP address reassigned, give the printer an address at the 
higher end of the range allowed by the router or device. For example, if your computer has IP address 
192.168.1.2, and your device allows IP addresses to 192.168.1.25, select an address between 
192.168.1.20 and 192.168.1.25. 

In IPv6 network configurations, the IPv6 address is assigned automatically. 
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To assign a static IP address to the printer: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. To select Network, press the arrow buttons, then press OK. 
4. To select TCP/IP, press the Down Arrow button, then press OK. 
5. To select IPv4, press the arrow buttons, then press OK. 
6. At Get IP Address, press OK. 
7. To select Panel, press the arrow buttons, then press OK to enable this option. 
8. To return to the IPv4 menu, press Return once. 
9. To select IP Address, press the arrow buttons, then press OK. 

When undefined, the address is 000.000.000.000. 
10. Set the IP address: 

a. In the first field, press the arrow buttons, or use the alphanumeric keypad, to enter the desired 
number. 

b. To move to the next field, press the Forward Arrow, then enter the desired number. 
c. Move to the next two fields and enter the desired numbers. 

 

Note: To scroll quickly to a number, press the Up or Down Arrow. To return to a field, press the Back 
Arrow. 

 

d. When finished, press OK to confirm the address. 
11. To return to IP Address, press the Back Arrow once. 
12. To select Network Mask, press the Down Arrow, then press OK. Repeat step 10 to set the Network 

Mask address. 
13. To return to Network Mask, press the Back Arrow once. 
14. To select Gateway Address, press the Down Arrow, then press OK. Repeat step 10 to set the 

Gateway Address. 
15. To return to the Ready screen, press Return. 
16. Print the System Settings Page to verify the new settings. 

You are ready to install software. 
 

See also: 
Online Support Assistant at: www.xerox.com/office/WC6025support 
 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
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Changing the IP Address Using CentreWare Internet Services 

To change the IP address of the printer using CentreWare Internet Services: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 27. 

 

2. Click the Properties link. 
If the Protocols link is not expanded under Properties, scroll to the Protocols link and expand it. 

3. Click TCP/IP. 
4. In the IPv4 section of the page, make the desired changes. For example, to change the way the 

printer acquires the IP address, in the Get IP Address field, select a method from the drop-down list. 
5. After changing the address information, scroll to the bottom of the page and click Save Changes. 
 

Changing the IP Address Using the Installer with USB 
1. From your installer disk, click Setup Printer and Install Software. 
2. At the License Agreement, select I Agree, then click Next. 
3. On the Select a Connection Method screen, click Wireless. 
4. On the Select a Wireless Setup Method screen, click Search for Networks. 
5. Ensure that the USB cable is connected properly. 
6. Select a network, then click Next. 
7. Enter the passphrase for your wireless network, then click Next. 
8. For the Configure Printer screen, click Advanced. 
9. For the IP Address Settings screen, modify the settings as needed then, click Next. 
10. At the prompt, remove the USB cable from the printer, then click Next. 
11. In the printer list, select your printer. 
12. In the Software and Documentation window, clear the check box for any undesired options. 
13. Click Next. 
14. To complete the installation, click Finish. 
 

Enabling the Printer for Scanning 

If the printer is connected to a network, you can scan to an FTP address, an email address, or a shared 
folder on your computer. First you must set up scanning in CentreWare Internet Services. For details, see 
CentreWare Internet Services. 

If the printer is connected with a USB cable, you can scan to a folder on your computer, or scan into an 
application. First you must install the scan drivers and the Express Scan Manager utility. 
 

Note: If your printer is connected using the USB cable, you cannot scan to an email address or a 
network location, such as a shared folder on your computer. 

For details, see Scanning Setup Overview on page 59. 
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Configuring General Settings Using CentreWare 
Internet Services 

This section includes: 
• Viewing Printer Information ........................................................................................................................................ 47 
• Configuring Tray Settings ............................................................................................................................................. 47 
• Configuring Printer Defaults ........................................................................................................................................ 48 
• Resetting the Printer ....................................................................................................................................................... 48 

You can configure general printer settings from your computer using your Web browser and CentreWare 
Internet Services. 

Note: A USB connection does not provide access to CentreWare Internet Services. 
 

Viewing Printer Information 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, for the General folder, click the plus symbol (+). 
4. For Printer Defaults, locate the printer model number, serial number, and printer name. 
5. For Port Enabling, locate the version numbers for each of the page description languages that are 

installed on the printer. 
 

Configuring Tray Settings 

Use this menu to configure the paper trays for the paper size and type, set custom sizes, and turn the 
display prompts on and off. 

To configure the tray settings: 
1. From the General menu, click Tray Management. 
2. For Tray Settings, from the lists, select the paper size and paper type. 
3. For custom paper sizes, for Custom Paper Length - Y, type a length, and for Custom Paper Width - X, 

type a width. 
4. To set the display to prompt you for the paper settings each time the paper tray is loaded, for Tray 

Display Prompt, select On. 
5. Click Save Changes. 
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Configuring Printer Defaults 

The Printer Defaults page displays the printer model information and product code or serial number. It 
also provides a place to enter the name and location of the printer and the name and email address of 
the contact. 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, for the General folder, click the plus symbol (+). 
4. Click Printer Defaults. 
5. In the fields, type descriptive information as needed. 
6. Click Save Changes. 
 

Resetting the Printer 

Using Software Resets to restart the printer is faster and wastes fewer consumables than powering the 
printer on and off. Restarting the printer can take up to five minutes during which time CentreWare 
Internet Services is not available. 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. To expand the menu, in the Properties pane, for the General folder, click the plus symbol (+). 
4. From the General menu, click Resets. 
5. To reset the network memory and restart the printer, for Reset network memory and restart the 

printer, click Start Printer. 
6. To restart the printer without resetting any of the default settings, for Restart the printer, click Start 

Printer. 
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Configuring General Setup Using the Control 
Panel 

This section includes: 
• Accessing Information About the Printer Using the Control Panel .............................................................. 49 
• Using the Power On Wizard ......................................................................................................................................... 49 
• Configuring System Settings ....................................................................................................................................... 50 
• Setting the Paper Size and Type ................................................................................................................................ 52 
 

Accessing Information About the Printer Using the Control Panel 

You can view information about the printer on the information pages. 
1. On the printer control panel, press the System button. 
2. Navigate to Information Pages, then press OK. 
3. Navigate to the desired report, then press OK. 
 

Using the Power On Wizard 

The Power On Wizard helps to configure several preliminary settings for the printer, including the 
country, date, time, and time zone. 

To use the Power On Wizard to set up the printer: 
1. On the printer control panel, press the System button. 
2. Use the Up and Down arrows to navigate to Admin Menu, then press OK. 
3. Navigate to System Setup, then press OK. 
4. To navigate to the Power On Wizard, use the Up or Down arrows, then select Power On Wizard. 
5. Select Yes, then press OK. 
6. Complete the steps in the wizard, then press OK. 
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Configuring System Settings 

This section includes: 
• Accessing the System Settings Menu ....................................................................................................................... 50 
• Setting the Power Saver Mode Timers ..................................................................................................................... 50 
• Setting the Auto Reset Timer ...................................................................................................................................... 50 
• Setting the Fault Time-Out Timer .............................................................................................................................. 51 
• Setting the Job Time-Out Timer ................................................................................................................................. 51 
• Setting the Clock .............................................................................................................................................................. 51 
• Setting Alerts ..................................................................................................................................................................... 51 
• Setting the Units for Custom Paper Sizes ............................................................................................................... 51 
• Setting the Low Toner Alert ......................................................................................................................................... 52 
• Setting the Show Paper Size/Type Error .................................................................................................................. 52 

You can use this menu to configure general settings of the printer, such as Power Saver timers, clock 
settings, and alert settings. 
 

Accessing the System Settings Menu 
1. On the printer control panel, press the System button. 
2. Use the Up and Down arrows to navigate to Admin Menu, then press OK. 
3. Navigate to System Setup, then press OK. 
 

Setting the Power Saver Mode Timers 
1. In the System Setup menu, navigate to Power Saver Timer, then press OK. 
2. Select the Power Saver Mode you want to change, then press OK. 
3. To select the desired time, press the arrow buttons, or enter a value using the numeric keypad. 

− Power Saver Mode 1 (Low Power): Set the timer from 1–60 minutes. 
− Power Saver Mode 2 (Sleep): Set the timer from 1–60 minutes. 

4. Press OK. 
 

Setting the Auto Reset Timer 

You can specify the time the printer waits for further input before it returns to standby mode. 

To set the Auto Reset timer: 
1. In the System Setup menu, navigate to Auto Reset, then press OK. 
2. To select a setting, press the arrow buttons, select it, then press OK. 
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Setting the Fault Time-Out Timer 

The fault timeout allows you to set how long the printer waits before canceling a print job that stops 
abnormally. 

To set the Fault Time-Out timer: 
1. In the System Setup menu, navigate to Fault Time-Out, then press OK. 
2. Select On, then press OK. 
3. To enter a time in seconds, use the numeric keypad, then press OK. 
 

Setting the Job Time-Out Timer 

You can specify the amount of time the printer waits for data to arrive from a computer before 
canceling the print job. 

To set the Job Time-Out timer: 
1. In the System Setup menu, navigate to Job Time-Out, then press OK. 
2. Select On, then press OK. 
3. To enter a time in seconds, use the numeric keypad, then press OK. 
 

Setting the Clock 
1. In the System Setup menu, navigate to Clock Settings, then press OK. 
2. Next to Date Format, Time Format, and Time Zone, select the setting for each option from the 

corresponding list. 
3. Using the selected format, next to Set Date, enter the date. 
4. Using the selected format, next to Set Time, enter the time. 
5. To exit the Clock Settings menu, press Back/Return. 
 

Setting Alerts 

You can set the printer to alert you when certain errors occur. 

To set the alert options: 
1. In the System Setup menu, navigate to Alert Tones, then press OK. 
2. To set an alert, select an alert type, then press OK. 
3. Select an alert tone volume, then press OK. 
 

Setting the Units for Custom Paper Sizes 
1. In the System Setup menu, navigate to mm/inch, then press OK. 
2. Select Millimeters (mm) or Inches ("), then press OK. 
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Setting the Low Toner Alert 
1. In the System Setup menu, navigate to Low Toner Alert Msg, then press OK. 
2. Select On, then press OK. 
 

Setting the Show Paper Size/Type Error 

You can set the printer to alert you when the paper size or type does not match the settings in the Tray 
Settings menu. The default option is On (Except A4/Ltr). The On (Except A4/Ltr) setting directs the 
printer to alert you for all errors except mismatches between A4 and Letter sizes. 

To set the Show Paper Size/Type Error alert: 
1. In the System Setup menu, navigate to Show Paper Size/Type Error, then press OK. 
2. Select an option. 
3. Press OK. 
 

Setting the Paper Size and Type 
1. On the printer control panel, press the System button. 
2. Navigate to Tray Settings, then press OK. 
3. Select MFP, then press OK. 
4. Navigate to Paper Size, then press OK. 
5. Select the paper size that matches the size of paper that is loaded in the tray, then press OK. 
6. Navigate to Paper Type, then press OK. 
7. Select the paper type that matches the type of paper that is loaded in the tray, then press OK. 
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Configuring Security Settings Using 
CentreWare Internet Services 

This section includes: 
• Opening the Security Menu ......................................................................................................................................... 53 
• Configuring Administrative Security Settings ....................................................................................................... 53 
• Configuring the Host Access List ................................................................................................................................ 54 
• Managing Certificates.................................................................................................................................................... 56 

Use security settings to configure administrative settings, authentication, user access and privileges, and 
service access. 

Note: For details, see the Help in CentreWare Internet Services. 
 

Opening the Security Menu 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder. 
 

Configuring Administrative Security Settings 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder. 
4. Click Administrator Security Settings. 
5. To turn on administrator privileges, select Enable Administrator Mode. 
6. Enter the user name and password, then reenter the password. 
7. To enter the default user name and password, leave the fields blank, then click OK. 
8. For Access denial by the authentication failure of the Administrator, enter the number of login 

attempts allowed before the user is locked out. 
9. Click Save Changes. 
 



Installation and Setup 

 

54 Xerox® WorkCentre® 6025 Multifunction Printer 
 User Guide 
 

Configuring the Host Access List 

The host access list controls access to the printer over LPR or Port 9100. You can enter up to five IP 
address/mask combinations, and then select to reject, accept, or turn off the filtering for each IP address. 
You can enter a specific IP address and address mask, or you can enter a range of IP addresses and 
address masks. If you leave IP address and Address Mask blank, anyone can access the printer. 

You can choose to allow printing from one specific IP address only. The following table shows an 
example. 
 

Access List IP Address Address Mask Active Mode 

1 192.168.200.10 255.255.255.255 Accept 
 

You can reject one specific IP address but allow printing from any other address. The following table 
shows an example. 
 

Access List IP Address Address Mask Active Mode 

1 192.168.200.10 255.255.255.255 Reject 

2 0.0.0.0 0.0.0.0 Accept 
 

The first row of the access list is the highest priority. When configuring a list with multiple rows, enter the 
smallest range first. Make the first row the most specific and the last row the most general. 

You can set up the host access list to accept or reject printing from a specific network or network mask. 
You can also accept printing from one IP address within a rejected network mask. The following table 
shows an example. 
 

Access List IP Address Address Mask Active Mode 

1 192.168.200.10 255.255.255.255 Accept 

2 192.168.200.0 255.255.255.0 Reject 

3 192.168.0.0 255.255.0.0 Accept 
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To configure the Host Access List: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In CentreWare Internet Services, click Properties. 
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder. 
4. Click Host Access List. 
5. In the IP Address field, enter the IP address of the host as X.X. X.X, where X is a number from 0 

through 255. For example, 192.168.200.10. 
6. In the Address Mask field, enter the network mask for the host as X.X. X.X, where X is a number from 

0 through 255. For example, 255.255.255.255. 
7. For the action the host takes with the IP address, for Active mode, select an option. 

− Off: You can use this setting to make a row of the access list inactive. Use this setting to enter a 
specific IP address or range of addresses before you apply Accept or Reject mode. 

− Accept: You can use this setting to allow the specified IP address or range of addresses access 
to the printer. 

− Reject: You can use this setting to deny the specified IP address or range of addresses access 
to the printer. 

8. Click Save Changes. 
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Managing Certificates 

This section includes: 
• About Security Certificates ........................................................................................................................................... 56 
• Enabling HTTPS Communication ............................................................................................................................... 57 
• Deleting a Digital Certificate ....................................................................................................................................... 57 
 

About Security Certificates 

A digital certificate is a file that contains data used to verify the identity of the client or server in a 
network transaction. A certificate also contains a public key used to create and verify digital signatures. 
One device proves its identity to another by presenting a certificate trusted by the other device. Or, the 
device can present a certificate signed by a trusted third party and a digital signature proving its 
ownership of the certificate. 

A digital certificate includes the following data: 
• Information about the owner of the certificate 
• The certificate serial number and expiration date 
• A public key 
• A purpose defining how the certificate and public key can be used 

This printer supports two types of certificates. 
• Device Certificate: This certificate contains a private key and a stated purpose that allows the 

printer to use it to prove identity. 
• Trusted Certificate: A self-signed certificate is a certificate from a device that verifies its identity to 

any devices that connect to it. 

Note: This printer does not support Certificate Authority (CA) certificates. 

To ensure that the printer can communicate with other devices over a secure trusted connection, both 
devices must have specific certificates installed. 
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Enabling HTTPS Communication 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. Click Properties. 
3. Select Security > SSL/TSL Communication. 
4. To configure the printer to create a digitally signed certificate, click Create New Certificate. 
5. To select the DKIM signature type, for Public Key Method, select RSA/SHA-256 or RSA/SHA-1. 
6. To select the size of the key, for Public Key Size, select the number of bits. 
7. For Issuer, type the name of the organization that issues the certificate. 
8. To set the number of days that the certificate is effective, for Validity, enter a number. 
9. Adjust the parameters of the new digital certificate as needed, then click Generate Certificate. 
10. For the new settings to take effect, restart your printer. 

Note: After you generate a signed certificate, Certificate Management appears in the Security 
menu. 

11. In the address bar, type the IP address of the printer, then press Enter or Return. 
12. To display the SSL page, select Properties > Security > SSL/TSL Communication. 
13. Ensure that Enabled SSL is selected. 
 

Deleting a Digital Certificate 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. Click Properties. 
3. In the navigation panel, click Security > SSL/TLS Server Communication, then click Delete All 

Certificates. 
4. To confirm, click Delete. 
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Configuring AirPrint 

Use AirPrint to print from a wired or wireless device directly without using a print driver. AirPrint is a 
software feature that allows you to print from wired or wireless Apple iOS-based mobile devices and Mac 
OS-based devices without the need to install a print driver. AirPrint-enabled printers allow you to print or 
fax directly from a Mac, an iPhone, iPad, or iPod touch. 

 
Notes: 

• Not all applications support AirPrint. 
• Wireless devices must join the same wireless network as the printer. 
• For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled. 
• The device that submits the AirPrint job must be on the same subnet as the printer. To allow 

devices to print from different subnets, configure your network to pass multicast DNS traffic 
across subnets. 

• The Mac OS device must be Mac OS 10.7 or later. 
• AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch 

(3rd generation or later), running the latest version of iOS. 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 27. 

2. Click Properties. 
3. If the Protocols link is not expanded under Properties, scroll to the Protocols link and expand it. 
4. Under Protocols, click AirPrint. 
5. To enable AirPrint, next to Enable AirPrint, click Turn On AirPrint. 

Note: AirPrint is enabled by default when IPP and Bonjour (mDNS) are both enabled. When AirPrint 
is enabled, Turn On AirPrint is not selectable. To disable AirPrint, disable either IPP or Bonjour 
(mDNS) protocols. 

− To change the printer name, in the Name field, enter a new name. 
− To enter a location for the printer, in the Location field, enter the location of the printer. 
− To enter a physical location or address for the printer, in the Geo-Location field, enter the 

geographic latitude and longitude coordinates in decimal form. For example, use coordinates 
like 45.325026, -122.766831 for a location. 

6. Click Save Changes. 
7. At the prompt, click Restart, or click Back to cancel. 

If you click Restart, the printer takes several minutes to restart and apply the new settings. 
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Setting Up Scanning 

This section includes: 
• Scanning Setup Overview ............................................................................................................................................. 59 
• Setting Up Scanning to a Shared Folder on Your Computer ........................................................................... 60 
• Setting Up Scanning to an FTP Server ..................................................................................................................... 63 
• Setting Up Scanning to an Email Address .............................................................................................................. 64 
• Setting Up Scanning With USB .................................................................................................................................. 64 
 

See also: 
Scanning on page 107 
 
 

Scanning Setup Overview 

If the printer is connected to a network, it is enabled for scanning. Before you can scan, you must do the 
following: 
• If you are scanning to a shared folder on your computer, share the folder, set the correct 

permissions, and add the folder as an Address Book entry in CentreWare Internet Services. 
• If you are scanning to an FTP server, add the FTP server and set the correct folder permissions as an 

Address Book entry in CentreWare Internet Services. 
• If you are scanning to an email address, configure the email server in CentreWare Internet Services. 

If the printer is connected using a USB cable, you cannot scan to an email address or a network location. 
You can scan to a folder on your computer, or scan into an application after installing the scan drivers 
and the Express Scan Manager utility. 

For details, see Installing the Software on page 38. 
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Setting Up Scanning to a Shared Folder on Your Computer 

This section includes: 
• Sharing a Folder Using Windows ............................................................................................................................... 60 
• Sharing the Folder Using Macintosh OS X Version 10.5 and Later ............................................................... 61 
• Adding a Folder as an Address Book Entry Using the Address Book Editor ............................................... 61 
• Adding a Folder as an Address Book Entry Using CentreWare Internet Services .................................... 62 

Before you can scan to a shared folder, you must share the folder, then add the folder as an Address 
Book entry in CentreWare Internet Services. 

For details, see CentreWare Internet Services. 
 

Sharing a Folder Using Windows 
1. Open Windows Explorer. 
2. Right-click the folder you want to share and select Properties. 
3. Click the Sharing tab, then click Share this folder. 
4. Click the Permissions button. 
5. Select the Everyone group, and verify that all permissions are enabled. 
6. Click OK. 
 

Note: Remember the Share name for later use. 
 

7. Click OK again. 
8. Open a DOS Command Prompt window: 

a. On the Start menu, select Run. 
b. In the Open field, type cmd and click OK. 

9. Type ipconfig, then press Enter. 
10. Record the IP address. 
11. Close the DOS Command Prompt window. 

The folder is ready. Now add the folder as an Address Book entry. For details, see Adding the Folder as 
an Address Book Entry Using CentreWare Internet Services on page 62. 
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Sharing the Folder Using Macintosh OS X Version 10.5 and Later 

To enable a folder on your Macintosh computer for network sharing: 
1. From the Apple menu, select System Preferences. 
2. From the View menu, select Sharing. 
3. From the Services list, select File Sharing. 
4. Click the plus icon (+) below the Shared Folders field. A folder list appears. 
5. Select the folder you want to share on the network, then click Add. 
6. Select the folder you want to share from the Shared Folders window. 
7. From the Users list, click Everyone. 
8. From the list to the right of the Users window, use the arrow buttons to select user privileges for the 

shared folder. 
9. Click the Options button. 
10. Do one or more of the following: 

− Select Share files and folders using AFP to share this folder with other Macintosh computers. 
− Select Share files and folders using FTP to share this folder with computer connected to an 

FTP server. 
− Select Share files and folders using SMB to share this folder with Windows computers. 

11. Select the On check box to the left of File Sharing in the Service pane. 
The folder and its contents are shared with network users. 

12. Close the Sharing window. 
 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and its subfolders. 

The folder is ready. Now add the folder as an Address Book entry. For details, see Adding the Folder as 
an Address Book Entry Using CentreWare Internet Services on page 62. 
 

Adding a Folder as an Address Book Entry Using the Address Book Editor 
1. Click Start > All Programs > Xerox Office Printing > WorkCentre 6025. 
2. In the left navigation pane, under Printer Address Book, click Server. 
3. For Name, enter the name of the shared file on your computer. 
4. For Server Type, select Computer (SMB). 
5. Click Computer Settings Wizard, then click Browse. 
6. Navigate to a shared folder on your computer. 
7. Click OK, then click Next. 
8. To give the printer access to the shared folder, enter a login name and password. 
9. Click Next, then click Finish. 
10. Click OK. 

The new entry appears in the Server pane. 
11. Click Save All. 
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Adding a Folder as an Address Book Entry Using CentreWare Internet Services 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 27. 

2. Click Address Book. 
3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book. 
4. Click Add next to any empty field, and enter the following information: 

− Name: Enter the name that you want to appear in the Address Book. 
− Server Type: Select Computer (SMB). 
− Host Address: Enter the IP address of your computer. 
− Port Number: Enter the default port number for SMB, 139, or select a number from the range 

provided. 
− Login Name: Enter your computer user name. 
− Login Password: Enter your computer login password. 
− Re-enter Password: Enter your login password again. 
− Name of Shared Directory: Enter a name for the directory or folder. For example, if you want 

the scanned files to go in a folder named scans type scans. 
− Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the 

scanned files to go in a folder named colorscans inside the scans folder, type /colorscans. 
5. Click Save Changes. 
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Setting Up Scanning to an FTP Server 

Before you set up scanning to an FTP Server, the server must have the proper software installed and be 
configured with shared folders for each user. 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 27. 

2. In CentreWare Internet Services, click Address Book. 
3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book. 
4. Next to any empty field, click Add. 
5. Enter the name to display in the address book. 
6. For Network Type, select Server (FTP). 
7. For Host Address, type the IP address or DNS name for the server. 
8. For Port Number, enter the default port number, or select a number from the range provided. 
9. For Login Name, type a login name for the FTP server. 
10. Type and confirm the password for the FTP server. 
11. For Name of Shared Directory, type the name of the destination folder on the FTP server. For 

example, to save scanned files to a shared folder named scans, type scans. 
12. For Subdirectory path, type the path of the folder as needed. For example, to save scans to a folder 

called colorscans that is one level below the scans folder, type /colorscans. 
13. Click Save Changes. A new address book entry is created. 
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Setting Up Scanning to an Email Address 

Before you can scan to an email address, you must configure the printer to communicate with your 
SMTP email server. Before you can scan to an email address, configure the printer to communicate with 
your SMTP email server. 

To configure the SMTP server settings: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 27. 

2. Click Properties. 
3. In the navigation pane, click Protocols > Email Server. 
4. For Return Email Address, type the email address that you want to use to send emails from the 

printer. 
5. For Host Address, type the IP address or DNS name for the server. 
6. For SMTP Port, enter the port number for the SMTP server. 
7. If the SMTP server requires authentication, select the Authentication Type, then enter the SMTP 

Login Name and SMTP Password. 

Note: Ensure that the authentication type is compatible with your SMTP server. 

8. Re-enter the password. 
9. Click Save Changes. 
 

Setting Up Scanning With USB 

If the printer is connected using a USB cable, you cannot scan to an email address or a network location. 
You can scan to a folder on your computer, or scan into an application after installing the scan drivers 
and the Express Scan Manager utility. 
 

Starting Express Scan Manager 

To start Express Scan Manager on Windows computers: 
1. Click Start > All Programs > Xerox Office Printing. 
2. Select your printer. 
3. Double-click Express Scan Manager. 

To start Express Scan Manager on Macintosh computers: 
1. Navigate to Applications > Xerox. 
2. Select your printer. 
3. Double-click Express Scan Manager. 
4. To accept the default Destination Path folder, click OK. 
5. To navigate to another folder, click Browse. 
6. Press OK. 
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Installing the Printer as a Web Services Device 

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated 
services across a network. WSD supports device discovery, control, and use. 

To install a WSD printer using the Add Printer Wizard: 
1. At your computer, access the Add Printer Wizard. 

− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2003 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 

2. To launch the Add Printer Wizard, click Add a Printer. 
3. In the list of available devices, select the one you want to use, then click Next. 
4. If the printer that you want does not appear in the list, click The printer that I want is not listed. 

a. Select Add a printer using a TCP/IP address or hostname, then click Next. 
b. For the Device type field, select Web Services Device. 
c. Enter the printer IP address in the Hostname or IP address field, then click Next. 

5. Complete the steps in the wizard, then click Finish. 
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Supported Paper 

This section includes: 
• Ordering Paper .................................................................................................................................................................. 68 
• General Paper Loading Guidelines ............................................................................................................................ 68 
• Paper That Can Damage Your Printer ...................................................................................................................... 69 
• Paper Storage Guidelines .............................................................................................................................................. 69 
• Supported Paper Types and Weights ....................................................................................................................... 70 
• Supported Standard Paper Sizes ................................................................................................................................ 70 
• Supported Custom Paper Sizes ................................................................................................................................... 70 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 

Ordering Paper 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6025supplies. 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=order&Language=English
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or 
gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 
 

Paper Type Weight 

Plain 
Plain Reloaded 
Letterhead 
Hole Punched 
Colored 

Heavyweight 60–90 g/m² 
Lightweight 60–80 g/m² 

Note: The default setting is Heavyweight. For 
details on how to change the paper type 
setting, see Adjusting Paper Type on page 134. 

Recycled 60–105 g/m² 

Bond, Heavy Plain 91–105 g/m² 

Lightweight Cardstock 
Lightweight Cardstock Reloaded 
Lightweight Glossy Cardstock 
Lightweight Glossy Cardstock Reloaded 

106–163 g/m² 

Labels  

Envelopes  
  
 

Supported Standard Paper Sizes 
 

European Standard Sizes North American Standard Sizes 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 

C5 envelope (162 x 229 mm, 
6.4 x 9 in.) 
DL envelope (110 x 220 mm, 
4.33 x 8.66 in.) 

Monarch envelope (98 x 190 mm, 
3.9 x 7.5 in.) 
No. 10 envelope (241 x 105 mm, 
4.1 x 9.5 in.) 

 
 

Supported Custom Paper Sizes 

You can use custom-sized paper within the following dimensions in your printer: 
• Width: 76.2–215.9 mm (3–8.5 in.) 
• Length: 127–355.6 mm (5–14 in.) 
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Loading Paper 

This section includes: 
• Loading Paper ................................................................................................................................................................... 71 
• Loading Paper in the Bypass Tray ............................................................................................................................. 74 
 

Loading Paper 

The main tray holds up to 150 sheets of paper. 

Notes: 

• To avoid paper jams, do not remove the dust cover while printing is in progress. 
• Use only laser print media. 

1. Open the front door. 

 
2. Pull the slide bar forward until it stops. 
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3. Pull the length guide forward until it stops. 

 
4. Move the width guides to the edges of the tray. 

 
5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
6. Load the paper into the tray with the top edge going into the printer and the print side up. 
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7. Adjust the width guides until they touch the edges of the paper. 

 
8. Push in the length guides and slide bar until they stop. 

 
Note: Depending on the size of the paper, first push the slide bar toward the printer until it stops. 
Pinch the length guide and slide it in until it touches the paper edge. 
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9. Place the bypass tray on the main tray, then align the tabs with the marks. 

 
10. If the paper that you loaded is not plain, set the correct paper type and size in your print driver. For 

details, see Using Custom Paper Sizes on page 89. 

Note: If you are printing on custom size paper, define the custom size in the printer properties before 
printing. 
 

Loading Paper in the Bypass Tray 
Note: To avoid paper jams, do not remove the bypass tray while printing is in progress. 

1. Open the front door. 

 
2. Place the bypass tray on the main tray, then align the tabs with the marks. 
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3. Move the width guides to the edges of the tray. 

 
4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
5. Load the paper into the tray with the top edge going into the printer and the print side up. 

 
6. Adjust the width guides until they touch the edges of the paper. 

 
7. If the paper you loaded is different from the paper in the main tray, set the correct paper type and 

size. Ensure that you change the paper type and size at the control panel and in your print driver 
software. For details, see Using Custom Paper Sizes on page 89. 

Note: If you are printing on custom size paper, define the custom size in the printer properties 
before printing. 
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Printing on Special Paper 

This section includes: 
• Printing Envelopes ........................................................................................................................................................... 77 
• Printing Labels ................................................................................................................................................................... 80 
• Printing on Glossy Cardstock ....................................................................................................................................... 81 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6025supplies. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=order&Language=English
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Printing Envelopes 

This section includes: 
• Guidelines for Printing Envelopes .............................................................................................................................. 77 
• Loading Envelopes ........................................................................................................................................................... 78 
• Loading Envelopes in the Bypass Tray ..................................................................................................................... 79 

You can print envelopes from either the main tray or the bypass tray. To print from either tray, select the 
correct envelope size in the control panel Main Tray settings and in the print driver. Print driver settings 
override control panel settings when you print using the print driver software on your computer. 
 

 CAUTION: Never use self-stick envelopes or envelopes with windows. They can damage the printer 
and cause jams. 

  

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 
 

Guidelines for Printing Envelopes 
• Print quality depends on the quality and construction of the envelopes. Try another envelope brand 

if you do not get desired results. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
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Loading Envelopes 

You can load up to five envelopes at a time in the main tray. 

To load envelopes: 
1. Slide open the width guides. 
2. Place envelopes in the main tray using one of the following methods: 

− Insert No. 10, DL, or Monarch envelopes with the print side up, flaps closed and facing down, 
and the flap side to the right. 

 
− Insert C5 envelopes with the print side up, flaps open and facing away from the printer. 

 

 
Notes: 

• To prevent wrinkling on No. 10, DL, C5, or Monarch envelopes, load them print side up, flaps 
open and facing away from the printer. 

• When you load envelopes long-edge feed, ensure that you specify landscape orientation in the 
print driver. 

3. Adjust the paper guides so they rest lightly against the edges of the envelopes. 
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Loading Envelopes in the Bypass Tray 

You can load one envelope at a time in the bypass tray. 
1. Slide open the width guides. 
2. Place an envelope in the bypass tray using one of the following methods: 

− Insert No. 10, DL, or Monarch envelopes with the print side up, flaps closed and facing down, 
and the flap side to the right. 

 
− Insert C5 envelopes with the print side up, flaps open and facing away from the printer. 

 
Notes: 

• To prevent wrinkling on No. 10, DL, C5, or Monarch envelopes, load them print side up, flaps 
open and facing away from the printer. 

• When you load envelopes long-edge feed, ensure that you specify landscape orientation in the 
print driver. 

3. Adjust the bypass tray width guides to rest against the edges of the envelope. 
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Printing Labels 

Ensure that label media is placed face-up in the main tray. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Before loading labels, remove all other paper from the tray. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 

 
 

Loading Labels in the Bypass Tray 
1. Remove all paper from the tray. 
2. Load labels face up with the top of the page going into the printer. 
3. Adjust the width guides until they touch the edges of the paper. 
4. On the control panel, change the type to Label. 
5. On the control panel, select the size. 
6. Touch OK. 
7. In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type 

setting. 
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Printing on Glossy Cardstock 

You can print on Lightweight Glossy Cardstock that is 163 g/m² or less. 
• Do not open sealed packages of glossy cardstock until you are ready to load them into the printer. 
• Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until 

ready to use. 
• Remove all other paper from the tray before loading glossy cardstock. 
• Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in 

the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal. 
• Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to 

curl and jam in the printer. 
• In the print driver software, select the desired glossy cardstock type or select the tray loaded with 

the desired paper. 

To optimize printing on glossy cardstock, do one or more of the following: 
• Adjust the paper type setting. For details, see Adjusting Paper Type on page 134. 
• Adjust the bias transfer roller. For details, see Adjusting the Bias Transfer Roller on page 134. 
• Adjust the fuser. For details, see Adjusting the Fuser on page 135. 
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• Using Custom Paper Sizes............................................................................................................................................. 89 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure 
that you have the correct print driver software installed on your computer. For details, see Installing the 
Software on page 38. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. 
3. At the printer control panel, specify the size and type. 
4. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
5. Select your printer. 
6. To access the print driver settings for Windows, select Properties or Preferences. For Macintosh 

select Xerox® Features. 

Note: Depending on your application, the title of the button varies. 

7. Modify the print driver settings as needed, then click OK. 
8. Click Print to send the job to the printer. 
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Selecting Printing Options 

This section includes: 
• Windows Printing Options ............................................................................................................................................ 85 
• Macintosh Printing Options ......................................................................................................................................... 87 

Note: Print driver settings override control panel settings when you print using the print driver 
software on your computer. 

 

Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. Navigate to the list of printers on your computer: 

− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2003 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then 
select Personalize > Control Panel Home > Devices and Printers. 

2. In the list, right-click the icon for your printer and click Printing Preferences. 
3. In the Printing Preferences window, click a tab, select the options, then click OK to save. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 



Printing 

 

86 Xerox® WorkCentre® 6025 Multifunction Printer 
 User Guide 
 

Selecting Printing Options for an Individual Job in Windows 

To use special printing options for a particular job, change the print driver settings in the application 
before sending the job to the printer. 
 

Note: The print driver includes online help with more information on selecting printing options. To 
access help from any print driver dialog box, click Help. 

 

To select printing options: 
1. With the desired document or graphic open in your application, open the Print dialog box. For most 

software applications, click File > Print or press CTRL+P. 
2. Select your printer, then click Properties to open the print driver dialog box. 
3. Make selections from the driver tabs as desired, beginning with settings in the Paper/Output tab. 
4. Click OK in the Properties window, then click OK in the Print window. 
 

Selecting Printing Defaults in Windows for a Shared Network Printer 
1. Navigate to the list of printers on your computer: 

− For Windows XP SP3, click Start > Settings > Printers and Faxes. 
− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2003 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then 
select Personalize > Control Panel Home > Devices and Printers. 

2. In the Printers folder, right-click the name of your print driver and select Properties. 
3. In the printer Properties dialog box, click the Advanced tab. 
4. On the Advanced tab, click Printing Defaults. 
5. Make your selections on the driver tabs as needed, then click Apply. 
6. Click OK to save your selections. 
 

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences. 
3. In the Printing Properties window, click the tabs, then select the desired settings 
4. At the bottom of the Printing Properties window, click Saved Settings, then click Save As. 
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, then 

click OK. 
6. To print using these options, select the name from the list. 
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Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer. 
3. Select Xerox® Features from the Copies & Pages menu. 
4. Select the desired printing options from the drop-down lists. 
5. Click Print to send the job to the printer. 
 
 

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the desired printing options from the drop-down lists in the Print dialog box. 
4. Click Presets > Save As. 
5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 
6. To print using these options, select the name from the Presets list. 
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Mobile Printing Options 

This printer can print from iOS and Android mobile devices. 
 

Printing with Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. 

For details, see Connecting with Wi-Fi Direct on page 37. 

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device. 

Note: Depending on which mobile device you are using, the printing procedure varies. 
 

Printing with AirPrint 

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint. To enable AirPrint for 
your printer, see Configuring AirPrint on page 58. To use AirPrint, ensure that your mobile device is 
connected to the wireless network. 

To print with AirPrint: 
1. Open the email, photograph, website page, or document that you want to print. 
2. Tap the Action icon. 
3. Tap Print. 
4. Select your printer, then set the printer options. 
5. Tap Print. 
 

Printing from a Mopria-Enabled Mobile Device 

Mopria is a software feature that enables users to print from mobile devices without requiring a print 
driver. You can use Mopria to print from your mobile device to Mopria-enabled printers. 

Notes: 

• Mopria and all of its required protocols are enabled by default. 
• Ensure that you have the latest version of the Mopria Print Service installed on your mobile 

device. You can obtain a free download from the Google Play Store. 
• Wireless devices must join the same wireless network as the printer. 
• The name and location of your printer appears in a list of Mopria-enabled printers on 

connected devices. 

To print using Mopria, follow the directions provided with your mobile device. 
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Using Custom Paper Sizes 

This section includes: 
• Defining Custom Paper Sizes ....................................................................................................................................... 89 
• Printing on Custom Paper Sizes .................................................................................................................................. 90 

The Xerox® WorkCentre® 6025 Multifunction Printer prints on custom paper sizes that are within the 
minimum and maximum size range supported by the printer. 
 

Defining Custom Paper Sizes 

To print custom paper sizes, define the custom width and length of the paper in the print driver software 
and on the printer control panel. When setting the paper size, ensure that you specify the same size as 
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override 
control panel settings when you print using the print driver software on your computer. 
 

Defining a Custom Paper Size for Windows 

You can save up to 20 custom paper sizes in the Windows print driver. Save each custom size with a 
unique name and the dimensions are retained until you change them. 
1. Navigate to the list of printers on your computer: 

− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2003 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then 
select Personalize > Control Panel Home > Devices and Printers. 

2. From the Printers and Faxes window, select a printer, right-click the printer, and select Properties. 

Notes: 

• For Windows 7, in the Devices and Printers window, right click the printer, and select Printer 
Properties from the middle of the drop-down list. 

• For Windows 7, you must have an Administrator Account to select Custom Settings in the print 
driver. 

3. In the Properties dialog box, click the Configuration tab, then click Custom Paper Size. 
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4. In the Custom Paper Size Settings dialog box, select the units of measurement to use. 
5. In the Custom Size Settings section, specify the size for the short edge and the long edge of the 

paper. 
6. Select the Name the Paper Size check box, type a name in the Paper Name dialog box, then click 

OK. 
7. In the Properties dialog box, click OK. 

The custom size appears in the Paper Size list in the print driver Properties window. 
 

Defining a Custom Paper Size for Macintosh 
1. In the application you are printing from, select File > Page Setup. 
2. From the Format For drop-down list, select the printer. 
3. From the Paper Size drop-down list, select Manage Custom Sizes. 
4. In the Custom Paper Sizes window, click plus (+) to add the new custom size. 
5. For the custom paper size, enter the width and height. 
6. In the Non-Printable Area drop-down list, select the printer. 
7. Double-click untitled, then type a name for the new custom size. 
8. Click OK to close the Custom Paper Sizes window. 
9. Click OK to close the Page Setup window. 

The new custom size is available in the Paper Size drop-down list of the print driver and in Page 
Setup. 

 

Note: To use the custom paper size, select Page Setup, and select the custom size that you created 
from the Paper Size drop-down list. 

 
 

Printing on Custom Paper Sizes 
 

Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer 
properties to define the custom size. For details, see Defining Custom Paper Sizes on page 89. 

 
 

Printing on Custom Paper Size Using Windows 
1. Load the custom-size paper in the tray. 
2. In the application, click File > Print and select your printer. 
3. In the Print dialog box, click Properties. 
4. On the Paper/Output tab, use the Paper Size drop-down list to select the desired custom size. 
 

Note: If you are printing on custom size paper, define the custom size in the printer properties 
before printing. 

 

5. From the Paper Type drop-down list, select the paper type. 
6. Select any other desired options, then click OK. 
7. In the Print dialog box, click OK to start printing. 
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Printing on Custom Paper Size Using Macintosh 
1. Load the custom-size paper. For details, see Loading Paper on page 71. 
2. In the application, click Page Setup. 
3. From the Paper Size drop-down list, select the custom paper size. 
4. Click OK. 
5. In the application, click Print. 
6. Click OK. 
 



Printing 

 

92 Xerox® WorkCentre® 6025 Multifunction Printer 
 User Guide 
 

Printing on Both Sides of the Paper 

This section includes: 
• Setting Up 2-Sided Printing.......................................................................................................................................... 92 
• Loading Paper for Manual 2-Sided Printing ........................................................................................................... 93 

The Xerox® WorkCentre® 6025 Multifunction Printer supports manual 2-sided printing. You can set 
printing preferences to print your jobs on both sides of the paper. 

Use 2-Sided Printing to specify the page orientation for the printed output. 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 
 

Portrait Landscape 

 

 

 

 

 

 

 

 
Portrait 
2-Sided Print 

Portrait 
2-Sided Print, Flip on Short 
Edge 

Landscape 
2-Sided Print 

Landscape 
2-Sided Print, Flip on Short 
Edge 

 
 

Setting Up 2-Sided Printing 

To set up manual 2-sided printing: 
1. From the File menu, select Print. 
2. Select the printer from the Select Printer list, then click Properties. 
3. From the Duplex window on the Paper/Output tab, select Flip on Long Edge or Flip on Short Edge. 
4. Select the Paper Size and Paper Type to match the paper you are using. 
5. To close the Printing Preferences dialog box, click OK. 
6. To start printing, click Print. 
 

Note: When you start manual 2-sided printing, the Manual Duplex Setup window appears. Do not 
close the window until you have completed the 2-sided printing. Once the window is closed, it cannot 
be reopened. 
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Loading Paper for Manual 2-Sided Printing 

For manual 2-sided printing, the back sides of the pages are printed first in reverse order. For a six-page 
document, the pages are printed page 6, page 4, and then page 2. Once the even pages are printed, the 
paper is reloaded. The odd pages are printed page 1, page 3, and then page 5. 
1. Load the paper to print the even pages. 

Note: Load letterhead into the main tray with the printed side down and the top going into the 
printer. 

Once the even pages have printed, the Error indicator lights and the Ready indicator flashes. 
2. Remove the printed pages from the output tray and reload them into the main tray without 

rotating or flipping the pages. The unprinted sides of the pages are facing up. 

 
3. Press OK. 

The odd pages are printed, page 1, page 3, then page 5. 
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Printing From a USB Flash Drive 

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. The print 
from USB function supports .jpg, .pdf, and .tiff file formats. 
 

Notes: 

• Before pressing the Print button or inserting the USB Flash drive, press the Power Saver button, 
then wait until the Power Saver indicator turns off. 

• You can print files stored using the Scan to USB Memory feature. File types created from other 
sources can fail to print properly. 

 

To print from the USB Flash drive: 
1. Insert the USB Flash Drive into the USB memory port on the printer. 
2. To select Print From, press the arrow buttons then press the OK button. 
 

Note: If the USB Flash drive was already in the USB memory port, press the Print button. 
 

3. To select a file, press the arrow buttons, then press OK. 
4. Do one of the following: 

− To print the file page-size, press the arrow buttons to select Auto On. 
− To print the file the original size, press the arrow buttons to select Auto Off. 
If necessary, press the arrow buttons to highlight the file name. 

5. Press the green Start button on the control panel. 
 

Note: For best results, save files in .jpg format. 
 

 



 

 Xerox® WorkCentre® 6025 Multifunction Printer 95 
 User Guide 
 

This chapter includes: 
• Making Copies ................................................................................................................................................................... 96 
• Copying an ID Card ......................................................................................................................................................... 98 
• Adjusting Copying Options .......................................................................................................................................... 99 
• Changing the Default Copy Options ...................................................................................................................... 104 
 

 6 Copying 
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Making Copies 

You can use the document glass to scan or copy a single page of a document at a time. The document 
glass accommodates original sizes up to 216 x 297 mm (8.5 x 11.7 in.). 

You can use the document glass to copy or scan the following types of originals. 
• Plain paper documents 
• Paper with paper clips or staples attached 
• Paper with wrinkles, curls, folds, tears, or notches 
• Coated or carbonless paper or items other than paper such as cloth or metal 
• Envelopes 
• Books 

To make a copy: 
1. Open the document cover. 

 
2. Place the original on the document glass. 
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3. Close the document cover. 

 
4. At the control panel, press the Copy button. 
5. To change a copying option, press the arrow buttons, select the option, then press OK. 

Note: For details on how to customize the copy settings, see Adjusting Copying Options on page 99. 

6. Using the control panel keypad, enter the desired number of copies. 
7. Press the Start button. 
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Copying an ID Card 

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied 
using the same location on the document glass. The printer stores both sides and prints them side by 
side on the paper. 

To copy an ID card: 
1. Press ID Card. 
2. Change the settings as needed. 
3. Lift the document cover. 
4. Place the ID card, or a document smaller than half the selected paper supply size, in the upper left 

corner of the document glass. 
5. Position the ID card approximately 6 mm (0.25 in.) from the upper left corner of the document 

glass. 
6. Close the document cover. 
7. To scan the first side of the document, press Start. 
8. If the document or ID card is 2-sided, open the document cover, then turn over the original 

document. 
a. Reposition the document about 6 mm (0.25 in.) from the upper left corner of the document 

glass, then close the document cover. 
b. Press the Start button. 

9. Remove the ID card from the scanner. 
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Adjusting Copying Options 

This section includes: 
• Basic Settings .................................................................................................................................................................. 100 
• Image-Quality Settings................................................................................................................................................ 102 
• Image-Layout Adjustments ....................................................................................................................................... 103 

You can adjust numerous options for your copy jobs, specify characteristics of the original documents, 
and customize the output. You can also modify the default settings for many options. For details, see 
Selecting the Default Copy Settings on page 104. 
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Basic Settings 

This section includes: 
• Selecting Color or Black and White Copies ........................................................................................................... 100 
• Specifying the Original Document Size ................................................................................................................. 100 
• Specifying the Output Size ......................................................................................................................................... 100 
• Collating Copies .............................................................................................................................................................. 101 
• Reducing or Enlarging the Image ............................................................................................................................ 101 
• Specifying the Original Document Type ............................................................................................................... 101 
 

Selecting Color or Black and White Copies 

If the original document contains color, you can create copies in full color or in black and white. The color 
mode indicators light to show the current setting. 

Press the Color Mode button to toggle the selection between color and black and white. 

Note: After the copy job is complete, the color mode returns to the default setting. 
 

Specifying the Original Document Size 
1. At the control panel, press the Copy button. 
2. To select Document Size, press the arrow buttons, then press OK. 
3. Select a document size from the list, then press OK. 
 

Specifying the Output Size 
1. At the control panel, press the Copy button. 
2. To select Output Paper Size, press the arrow buttons, select an option, then press OK. 
3. Select a document size from the list, then press OK. 
 



Copying 

 

 Xerox® WorkCentre® 6025 Multifunction Printer 101 
 User Guide 
 

Collating Copies 

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a 
six-page document, the copies are printed in this order: 

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6 

Uncollated copies print in the following order: 

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6 

To select a collating option: 
1. At the control panel, press the Copy button. 
2. To specify collation, press the arrow buttons, select Collated, then press OK. 
3. Select On, then press OK. 

Note: If you copy documents with a large amount of data, you can exhaust available memory. To 
conserve memory, or if a memory shortage occurs, you can turn off Collated. 

 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the image: 
1. At the control panel, press the Copy button. 
2. To reduce or enlarge images, press the arrow buttons, select Reduce/Enlarge, then press OK. 
3. Do one of the following: 

− To select a preset image size, press the up or down arrow buttons, select the size, then press OK. 
− To set the copy size in 1% increments, press the arrow buttons, or to enter values directly, use 

the keypad. 
4. Press OK. 
 

Specifying the Original Document Type 

The printer optimizes the image quality of the copies based on the type of images in the original 
document and how the original was created. 

To specify the type of the original document: 
1. At the control panel, press the Copy button. 
2. To specify the original document type, press the arrow buttons, select Original Type, then press OK. 
3. Select the document type. 

− Text: Use this option for black and white or colored text. 
− Mixed: Use this option for both text and photographs, such as magazines or newspapers. 
− Photo: Use this option for photographs. 

4. Press OK. 
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Image-Quality Settings 

This section includes: 
• Making the Image Lighter or Darker ...................................................................................................................... 102 
• Adjusting the Sharpness .............................................................................................................................................. 102 
• Setting Auto Exposure .................................................................................................................................................. 102 

You can adjust the image quality of your copy. 
 

Making the Image Lighter or Darker 
1. At the control panel, press the Copy button. 
2. Navigate to Lighten/Darken, then press OK. 
3. To lighten or darken the image, press the left or right arrow buttons to move the slider. 
4. Press OK. 
 

Adjusting the Sharpness 
1. At the control panel, press the Copy button. 
2. To select sharpness options, press the arrow buttons, select Sharpness, then press OK. 
3. Select a sharpness setting, then press OK. 
 

Setting Auto Exposure 

Paper that is close to white, such as newsprint or parchment, can cause the printer to put toner on the 
entire page. The Auto Exposure setting removes the light background and only prints the image. 

To set Auto Exposure: 
1. At the control panel, press the Copy button. 
2. Navigate to Auto Exposure, then press OK. 
3. Select On, then press OK. 
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Image-Layout Adjustments 

You can adjust the layout of your copy. 
• You can copy a single page and have it print multiple times onto one or both sides of the paper. The 

printer reduces the pages proportionally to fit. 
• You can set copy margins to adjust the placement of the image on the page. 

To print multiple pages per side: 
1. At the control panel, press the Copy button. 
2. To select multiple copies per side, press the arrow buttons, select N-Up, then press OK. 
3. Select an option: 

− Off: This option copies one original image onto one side of a page. 
− Auto: Copies two original pages, reduces the images, and prints them onto one side of a page. 
− ID Card Copy: Copies two original size images onto one side of a page. 
− Manual: Reduces the two original images, as specified in Reduce/Enlarge, and prints them onto 

one side of a page. 
4. Press OK. 

To set the copy margins: 
1. At the control panel, press the Copy button. 
2. To select a setting, press the arrow buttons, select it, then press OK. 
3. To set the margin value, use the arrow buttons, then press OK. 
4. Press OK. 
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Changing the Default Copy Options 

This section includes: 
• Changing the Color Mode ........................................................................................................................................... 104 
• Changing the Auto Exposure Level ......................................................................................................................... 104 
• Changing the Color Balance ...................................................................................................................................... 105 

The printer uses the default copy settings on all copy jobs unless you change them for an individual job. 
You can modify the default copy settings. 

To change the default copy settings: 
1. On the printer control panel, press the System button. 
2. To specify default settings, press the arrow buttons, select Default Settings, then press OK. 
3. Select Copy Defaults, then press OK. 
4. To select a setting, press the arrow buttons, select it, then press OK. 
5. To confirm a new setting, select the desired setting, then press OK. 
6. To return to the Ready screen, press Return. 
 

Changing the Color Mode 
1. To select Color, press the arrow buttons, then press OK. 
2. Select a color setting: 

− Black & White 
− Color 

3. Press OK. 
 

Changing the Auto Exposure Level 
1. To select Auto Exposure Level, press the arrow buttons, then press OK. 
2. Select an auto exposure setting: 

− Off 
− On 
The default setting is On. 

3. Press OK. 
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Changing the Color Balance 

The Color Balance control allows you to adjust the print color of your printer. Each of the four primary 
colors of red, green, blue, and gray balance, have five density settings. The density settings adjust the 
output based on the level of color saturation. Adjusting the setting negatively lowers the density and 
lightens the output. Adjusting the setting positively increases the density and darkens the output. 
Examples of low density areas include faces and sky. 

To change the color balance: 
1. To select Color Balance, press the arrow buttons, then press OK. 
2. Select the color you want to adjust, then press OK. 
3. To adjust the density setting from -2 through +2, press the arrow buttons. 
4. Press OK. 
5. Select another color and adjust its density, or press the Return button to return to the Ready screen. 
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This chapter includes: 
• Scanning Using the Document Glass ..................................................................................................................... 108 
• Scanning to a USB Flash Drive .................................................................................................................................. 109 
• Scanning to a Folder on a USB Connected Computer ..................................................................................... 110 
• Scanning to a Shared Folder on a Network Computer .................................................................................... 111 
• Scanning to an Email Address ................................................................................................................................... 114 
• Scanning to an FTP Server .......................................................................................................................................... 115 
• Scanning Images into an Application on a USB Connected Computer .................................................... 116 
• Adjusting Scanning Settings ...................................................................................................................................... 118 
• Changing the Default Scan Settings ...................................................................................................................... 121 
 

See also: 
Setting up Scanning on page 59 
 
 

 7 Scanning 
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Scanning Using the Document Glass 

You can use the document glass to scan or copy a single page of a document at a time. The document 
glass accommodates original sizes up to 216 x 297 mm (8.5 x 11.7 in.). 

You can use the document glass to copy or scan the following types of originals. 
• Plain paper documents 
• Paper with paper clips or staples attached 
• Paper with wrinkles, curls, folds, tears, or notches 
• Coated or carbonless paper or items other than paper such as cloth or metal 
• Envelopes 
• Books 
 

Loading Documents for Scanning 

Position the original document as shown. 
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Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
supports .jpg, .pdf, and .tiff file formats. 
 

Note: Before pressing the Scan button or inserting the USB Flash drive, press the Power Saver 
button, then wait until the Power Saver indicator turns off. 

 

1. Load the original on the document glass or in the automatic document feeder. 
2. Do one of the following: 

− Insert your USB Flash drive in the USB port on the front of the printer, then select Scan to using 
the arrow buttons. 

− Press the Scan button, press the arrow buttons to select Scan to USB Memory, then press OK. 
3. Press OK. 
4. Do one of the following: 

− To save the scanned file directly to the USB Flash drive, select Save to USB Drive, then press 
OK. 

− To save the scanned file to a folder on the USB Flash drive, press the arrow buttons to navigate 
to the folder, then press OK. 

5. At Save to USB Drive or Save to this folder, press OK. 
6. To select any scanning options you want to change, press the arrow buttons. 
7. To select Scan to, press the arrow buttons. 
8. To begin the scan, press Start. 
9. If the Another Page? prompt appears, select an option: 

− No completes the scanning process. 
− Yes prompts you to place the next page on the document glass. 

10. Select Continue or Cancel the Action. 
11. Press OK. 

The printer scans your images to the folder you specified. 
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Scanning to a Folder on a USB Connected 
Computer 

1. Start Express Scan Manager: 
− Windows: Click Start > Programs > Xerox. Select your printer from the list. Double-click Express 

Scan Manager. 
− Macintosh: Navigate to Applications > Xerox. Select your printer from the list. Double-click 

Express Scan Manager. 
2. Click OK to accept the default Destination Path folder, or click Browse to navigate to another folder. 
3. Press OK. 
4. Load the original on the document glass or in the automatic document feeder. 
5. On the printer control panel, press the Scan button. 
6. To select Scan to Computer (USB), press the arrow buttons, then press OK. 
7. To change any of the options, press the arrow buttons to select the option, then press OK. 
8. To begin the scan, press the arrow buttons to select Scan to, then press Start. 

An Express Scan Manager dialog box opens on your computer to indicate the progress. The printer 
scans your documents to the output destination specified in Express Scan Manager. 
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Scanning to a Shared Folder on a Network 
Computer 

This section includes: 
• Sharing a Folder on a Windows Computer ........................................................................................................... 111 
• Sharing a Folder Using Macintosh OS X Version 10.5 and Later ................................................................. 112 
• Adding a Folder as an Address Book Entry Using CentreWare Internet Services .................................. 113 
• Scanning to a Folder on a Network Computer.................................................................................................... 113 

Before using the printer as a scanner on a network, you must: 
1. Create a shared folder on your computer hard drive. 
2. Create an address using CentreWare Internet Services or the Address Book Editor pointing the 

scanner to the computer. 
 

Note: For more information, see Connecting the Printer on page 32. 
 
 

Sharing a Folder on a Windows Computer 
1. Open Windows Explorer. 
2. Right-click the folder you want to share and select Properties. 
3. Click the Sharing tab, then click Share this folder. 
4. Click the Permissions button. 
5. Select the Everyone group, and verify that all permissions are enabled. 
6. Click OK. 
 

Note: Remember the Share name for later use. 
 

7. Click OK again. 
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Sharing a Folder Using Macintosh OS X Version 10.5 and Later 
1. From the Apple menu, select System Preferences. 
2. From the View menu, select Sharing. 
3. From the Services list, select File Sharing. 
4. Click the plus icon (+) below the Shared Folders field. A folder list appears. 
5. Select the folder you want to share on the network, then click Add. 
6. Select the folder you want to share from the Shared Folders window. 
7. From the Users list, click Everyone. 
8. From the list to the right of the Users window, use the arrow buttons to select user privileges for the 

shared folder. 
9. Click the Options button. 
10. Do one or more of the following: 

− Select Share files and folders using AFP to share this folder with other Macintosh computers. 
− Select Share files and folders using FTP to share this folder with computer connected to an 

FTP server. 
− Select Share files and folders using SMB to share this folder with Windows computers. 

11. Select the On check box to the left of File Sharing in the Service pane. 
The folder and its contents are shared with network users. 

12. Close the Sharing window. 
 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and its subfolders. 
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Adding a Folder as an Address Book Entry Using CentreWare Internet 
Services 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 27. 

 

2. Click Address Book. 
3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book. 
4. Click Add next to any empty field, and enter the following information: 

− Name: Enter the name that you want to appear in the Address Book. 
− Network Type: Select Computer (SMB). 
− Host Address: Enter the IP address of your computer. 
− Port Number: Enter the default port number for SMB, 139, or select a number from the range 

provided. 
− Login Name: Enter your computer user name. 
− Login Password: Enter your computer login password. 
− Re-enter Password: Enter your login password again. 
− Name of Shared Directory: Enter a name for the directory or folder. For example, if you want 

the scanned files to go in a folder named scans type /scans. 
− Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the 

scanned files to go in a folder named colorscans inside the scans folder, type /colorscans. 
5. Click Save Changes. 
 

Scanning to a Folder on a Network Computer 
1. On the printer control panel, press the Scan button. 
2. To select Scan to Network, press the arrow buttons, then press the OK button. 
3. At Scan to, press OK. 
4. At Computer (Network), press OK. 
5. To select the shared folder on your computer, press the arrow buttons, then press OK. 
6. To change any other scan settings, press the arrow buttons to select the setting, and make the 

desired changes. For details, see Adjusting Scanning Settings on page 118. 
7. To begin the scan, press the Start button. 
8. If the Another Page? prompt appears, select an option: 

− No completes the scanning process. 
− Yes prompts you to place the next page on the document glass. 

9. Select Continue or Cancel the Action. 
10. Press OK. 

The printer scans the documents to the shared folder on your computer. 
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Scanning to an Email Address 

Before scanning to an email address, you must set up the printer up with the email server information. 
For details, see Setting Up Scanning to an Email Address on page 64. 

To scan an image and send it to an email address: 
1. On the printer control panel, press the Scan button. 
2. To select Scan to Email, press the arrow buttons, then press OK. 
3. At Email to, press OK. 
4. Select the method for selecting the recipient: 

− Keypad allows you to enter the email address manually. Use the keypad to enter the address. 
− Address Book allows you to select an email address from the Address Book. 
− Email Group allows you to select a group email address from the Address Book. 

 

Note: When using the Address Book, press the arrow buttons to select the address for the desired 
recipient. Press the Forward Arrow button to select TO or BCC. When finished selecting addresses, 
press OK. 

 

5. To begin the scan, press the Start button. 
6. If the Another Page? prompt appears, select an option: 

− No completes the scanning process. 
− Yes prompts you to place the next page on the document glass. 

7. Select Continue or Cancel the Action. 
8. Press OK. 

The printer sends the scanned image as email attachments of the default file type. 
 

See also: 
Adjusting Scanning Settings on page 118 
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Scanning to an FTP Server 

Before using this feature, you must: 

1. Set up an FTP server. 
2. Create an address for the printer to use. You can use CentreWare Internet Services or the Address 

Book Editor. 

To scan to an FTP server: 
1. Load the original on the document glass or in the automatic document feeder. 
2. On the printer control panel, press the Scan button. 
3. To select Scan to Network, press the arrow buttons, then press OK. 
4. At Scan to, press OK. 
5. To select Server (FTP), press the arrow buttons, then press OK. 
6. To select the FTP address, press the arrow buttons, then press OK. 
7. To begin the scan, press the Start button. 

The printer scans the document and places the image on the FTP server. 
 

See also: 
Adjusting Scanning Settings on page 118 
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Scanning Images into an Application on a USB 
Connected Computer 

This section includes: 
• Scanning an Image into an Application ............................................................................................................... 116 
• Scanning an Image Using Windows 8 ................................................................................................................... 116 
• Scanning an Image Using Windows Vista or Windows 7 ............................................................................... 117 
• Scanning an Image Using Windows XP ................................................................................................................ 117 

You can import images directly from the scanner into a folder on your computer. With a Macintosh 
computer, and some Windows applications, you can import the images directly into an application. 
 

Scanning an Image into an Application 
Note: Some Windows applications, including Office 2007, do not support this feature. 

1. Open the file to insert the image. 
2. In the file, select the insertion point for the image. 
3. From the Windows toolbar, click Image > Picture > From Scanner or Camera. 
4. From the Insert Image from Camera or Scanner window, select your device. 
5. Click Custom Insert. 
6. From the Basic Scanning tab, for Scan From, select an option. 
7. To change any of the scanning settings, select them as needed. 
8. To adjust crop lines, select Preview as needed. 
9. Click Scan. 

The printer scans the document and places the image in your application. 
 

Scanning an Image Using Windows 8 
1. From the Windows 8 Modern User Interface app, to access the All Apps menu, right-click anywhere 

on the screen, then find the All Apps icon at bottom right. 
2. For Windows System heading, click Control Panel. 
3. For Hardware and Sound, click View devices and printers. 
4. Right-click on your printer, then click New Scan. 
5. Select the scan settings, then click Preview or Scan. 
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Scanning an Image Using Windows Vista or Windows 7 
1. On your computer, select Start > All Programs > Windows Fax and Scan. 
2. Click New Scan. 
3. If prompted, select your printer, then click OK. 
4. Select the scan settings. 
5. To preview the document or select a portion of the document to scan, select Preview. 

The printer scans a preview copy of the image. 
6. To select part of the document, clear Preview or scan images as separate files, then to resize the 

frame, use the corner points. 
7. Click Scan. 

The scanned image is stored in the default Scanned Documents folder or in a folder that you 
selected. 

 

Scanning an Image Using Windows XP 
1. On your computer, select Start > Control Panel. 
2. Double-click Scanners and Cameras. 
3. In the Scanners and Cameras window, click Next. 
4. Double-click Xerox WC6025. 
5. Select an option: 

− Color picture 
− Grayscale picture 
− Black and white picture or text 
− Custom 

6. Select the paper source: 
− Document Glass 
− Document Feeder 

7. To preview the document or select a portion of the document to scan, select Preview. 
The printer scans a preview copy of the image. 

8. To select a portion of the document to scan, click and drag the corner points to resize the frame. 
9. Click Next. 
10. Type a name for this group of pictures. 
11. Select a file format. 
12. Type a path name or browse to a location for the scanned images. 
13. To save your image to the folder, in the Other Options window, select Nothing. 
14. Click Next. 
15. To view the scanned image, click the folder link in the window. 
16. Click Finish. 

The image is stored in the folder and ready for use in your applications. 
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Adjusting Scanning Settings 

This section includes: 
• Setting the File Format ................................................................................................................................................ 118 
• Setting the Color Mode ................................................................................................................................................ 118 
• Setting the Scan Resolution ....................................................................................................................................... 119 
• Specifying the Original Size........................................................................................................................................ 119 
• Making the Image Lighter or Darker ...................................................................................................................... 119 
• Adjusting the Sharpness .............................................................................................................................................. 119 
• Changing the Auto Exposure Level ......................................................................................................................... 119 
• Setting the Margins ....................................................................................................................................................... 120 

You can modify the scan settings for individual jobs, once you select the scan mode. 

You can also change the default values of some settings. For details, see Changing the Default Scan 
Settings on page 121. 
 

Setting the File Format 
1. To select File Format, press the arrow buttons, then press OK. 
2. Select a setting. 
3. Press OK. 
 

Setting the Color Mode 

If the original image contains color, you can scan the image in color or in black and white. Selecting 
black and white significantly reduces the file size of the scanned images. 

To set the color mode: 
1. To select Color Mode, press the arrow buttons, then press OK. 
2. Select a color mode. 
3. Press OK. 
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Setting the Scan Resolution 

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both 
the size and image quality of the scanned image file. Higher scan resolution produces better image 
quality and a larger file size. 

To set the scan resolution: 
1. To select Resolution, press the arrow buttons, then press OK. 
2. Select an option. 
3. Press OK. 
 

Specifying the Original Size 
1. To select Document Size, press the arrow buttons, then press OK. 
2. Select the document size. 
3. Press OK. 
 

Making the Image Lighter or Darker 
1. To select Lighten/Darken, press the arrow buttons, then press OK. 
2. To lighten or darken the image, press the arrow buttons to move the slider. 
3. Press OK. 
 

Adjusting the Sharpness 
1. To select Sharpness, press the arrow buttons, then press OK. 
2. Select a sharpness setting: 

− Sharpest 
− Sharper 
− Normal 
− Softer 
− Softest 
The default setting is Normal. 

3. Press OK. 
 

Changing the Auto Exposure Level 
1. To select Auto Exposure Level, press the arrow buttons, then press OK. 
2. Select an auto exposure setting: 

− Off 
− On 
The default setting is On. 

3. Press OK. 
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Setting the Margins 
1. To select the margin you want to change, press the arrow buttons for: 

− Margin Top/Bottom 
− Margin Left/Right 
− Margin Middle 

2. Press OK. 
3. Adjust the margins from 0.0–2.0 in. using the arrow buttons. 
4. Press OK. 
5. Repeat the steps for other margins, then press the Return button. 
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Changing the Default Scan Settings 

This section includes: 
• Setting the Scan to Network Option ....................................................................................................................... 121 
• Setting the File Format ................................................................................................................................................ 122 
• Changing the Color Mode ........................................................................................................................................... 122 
• Setting the Scan Resolution ....................................................................................................................................... 122 
• Setting the Color Button Sets .................................................................................................................................... 122 
• Specifying the Original Size........................................................................................................................................ 122 
• Making the Image Lighter or Darker ...................................................................................................................... 123 
• Adjusting the Sharpness .............................................................................................................................................. 123 
• Changing the Auto Exposure Level ......................................................................................................................... 123 
• Setting the Margins ....................................................................................................................................................... 123 
• Setting the TIFF File Format ...................................................................................................................................... 124 
• Setting the Image Compression .............................................................................................................................. 124 
• Setting the Maximum Email Size ............................................................................................................................. 124 

The printer uses the default scan settings on all scan jobs unless you change them for an individual job. 
You can modify the default scan settings. 

To change the default scan settings: 
1. On the printer control panel, press the System button. 
2. To specify default settings, press the arrow buttons, select Default Settings, then press OK. 
3. Select Scan Defaults, then press OK. 
4. To select the option that you want to modify, press the arrow buttons, then press OK. 
5. To select the new setting, press the arrow buttons, then press OK. 

Press Return at any time to return to the previous selection. 
 

Setting the Scan to Network Option 
1. To select Scan to Network, press the arrow buttons, then press OK. 
2. To select a setting, press the arrow buttons: 

− Computer (Network) 
− Server (FTP) 

3. Press OK. 
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Setting the File Format 
1. To select File Format, press the arrow buttons, then press OK. 
2. Select a setting. 
3. Press OK. 
 

Changing the Color Mode 
1. To select Color, press the arrow buttons, then press OK. 
2. Select a color setting: 

− Black & White 
− Color 

3. Press OK. 
 

Setting the Scan Resolution 

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both 
the size and image quality of the scanned image file. Higher scan resolution produces better image 
quality and a larger file size. 

To set the scan resolution: 
1. To select Resolution, press the arrow buttons, then press OK. 
2. Select an option. 
3. Press OK. 
 

Setting the Color Button Sets 
1. To select Color Button Set, press the arrow buttons, then press OK. 
2. Select B & W Button, then press OK. 
3. Select a setting: 

− Black & White 
− Grayscale 

4. Press OK. 
5. Select Color Button, then press OK. 
6. Select a setting: 

− Color 
− Color (Photo) 

7. Press OK. 
 

Specifying the Original Size 
1. To select Document Size, press the arrow buttons, then press OK. 
2. Select the document size. 
3. Press OK. 
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Making the Image Lighter or Darker 
1. To select Lighten/Darken, press the arrow buttons, then press OK. 
2. To lighten or darken the image, press the arrow buttons to move the slider. 
3. Press OK. 
 

Adjusting the Sharpness 
1. To select Sharpness, press the arrow buttons, then press OK. 
2. Select a sharpness setting: 

− Sharpest 
− Sharper 
− Normal 
− Softer 
− Softest 
The default setting is Normal. 

3. Press OK. 
 

Changing the Auto Exposure Level 
1. To select Auto Exposure Level, press the arrow buttons, then press OK. 
2. Select an auto exposure setting: 

− Off 
− On 
The default setting is On. 

3. Press OK. 
 

Setting the Margins 
1. To select the margin you want to change, press the arrow buttons for: 

− Margin Top/Bottom 
− Margin Left/Right 
− Margin Middle 

2. Press OK. 
3. Adjust the margins from 0.0–2.0 in. using the arrow buttons. 
4. Press OK. 
5. Repeat the steps for other margins, then press the Return button. 
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Setting the TIFF File Format 
 

Note: TIFF files created by this printer can fail to open properly in some computer applications. 
 

1. To select TIFF File Format, press the arrow buttons, then press OK. 
2. Select a setting: 

− TIFF V6 
− TTN2 

3. Press OK. 
 

Setting the Image Compression 
1. To select Image Compression, press the arrow buttons, then press OK. 
2. Select a setting: 

− Higher 
− Normal 
− Lower 

3. Press OK. 
 

Setting the Maximum Email Size 
1. To select Max Email Size, press the arrow buttons, then press OK. 
2. To set a size from 50–16384 KB, press the arrow buttons, or use the alphanumeric keypad. 

The default setting is 2048 KB. 
3. Press OK. 
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Cleaning the Printer 

This section includes: 
• General Precautions ...................................................................................................................................................... 126 
• Cleaning the Scanner ................................................................................................................................................... 127 
• Cleaning the Exterior .................................................................................................................................................... 128 
• Cleaning the Interior .................................................................................................................................................... 128 
 

General Precautions 
 

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as 
directed in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized 
spray cleaners increases the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the imaging units. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Scanner 
1. Moisten a soft, lint-free cloth with the glass cleaner of your choice. 
2. Remove any paper or other media from the output tray. 
3. Open the document cover. 

 
4. Wipe the surface of the document glass until it is clean and dry. 

 
5. Wipe the white underside of the document cover until it is clean and dry. 
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6. Close the document cover. 

 
 

Cleaning the Exterior 

Clean the exterior of the printer once a month. 
• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 
• After cleaning, wipe with a dry, soft cloth. 
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain 

off. 
 

 CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer 
through a gap and cause problems. Never use cleaning agents other than water or mild detergent. 

 
 

Cleaning the Interior 

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing 
the printer covers and doors. 
• Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 150. 
• Remove any dust or stains with a dry, clean cloth. 
  

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If 
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off 
the printer immediately and wait 20 minutes for the fuser to cool. Try to remove the jam after the 
printer has cooled. 
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Cleaning the LED Lenses 
1. Turn off the printer. 
2. Open the side door. 

 
3. Pinch the release tab on the toner cartridge as shown. 

 
4. Pull out the toner cartridge. 

Note: To avoid spilling toner, pull out the toner cartridge slowly. 
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5. Remove the remaining toner cartridges in the same manner. 
6. Pull out the cleaning rod. 

Note: To remove toner and debris from the top of the cleaning rod, wipe it with a clean lint-free 
cloth. 

 
7. Insert the cleaning rod into the hole indicated by the arrow in the middle of the toner cartridge slot. 

Push in the cleaning rod until it stops, then pull it out. 

 
8. Repeat the procedure for the holes in the other three slots. 
9. Return the cleaning rod to its original location. 
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10. Align the black toner cartridge with the rear toner slot. Press firmly near the center of the cartridge 
until it clicks into place. 

 
11. Replace the remaining three toner cartridges in the same manner. 
12. Close the side door. 

 
 

Cleaning the Toner Density Sensor 

Clean the color toner density (CTD) sensor when an alert for the CTD sensor appears on the control 
panel or in the PrintingScout Printer Status window. 

To clean the toner density sensor: 
1. Turn off the printer. 
2. Push down on the rear door release and pull open the door. 
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3. Use a dry cotton swab to clean the color toner density sensors. 

 
4. Close the rear door. 
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Adjustments and Maintenance Procedures 

This section includes: 
• Color Registration .......................................................................................................................................................... 133 
• Adjusting Paper Type ................................................................................................................................................... 134 
• Adjusting the Bias Transfer Roller ........................................................................................................................... 134 
• Adjusting the Fuser ....................................................................................................................................................... 135 
• Refreshing the Bias Transfer Roller ......................................................................................................................... 135 
• Adjusting the Altitude .................................................................................................................................................. 135 
 

Color Registration 

The printer automatically adjusts the color registration when automatic adjustment is turned on. You 
can also adjust color registration manually any time the printer is idle. You must adjust the color 
registration any time the printer is moved. If you are having printing problems, adjust the color 
registration. 
 

Setting Automatic Color Registration 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select Auto Regi Adjust, then press OK. 
5. Select On, then press OK. 
6. To return to the Ready screen, press Return. 
 

Performing an Automatic Color Registration Adjustment 

Automatic color registration adjustment occurs every time a new toner cartridge is installed. You can run 
this adjustment at other times as needed. 

To perform an automatic color registration adjustment: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select Adjust Color Regi, then press OK. 
5. At Auto Adjust, press OK. 
6. At the Are you sure? prompt, press the arrow buttons to select Yes. 
7. To begin the calibration, press OK. 
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Adjusting Paper Type 

Use Adjust Paper Type to compensate for paper thickness within a paper type. If the printed image is 
too light, use a heavier setting for the paper you are using. If the printed image is mottled or 
blotchy-looking, decrease the setting for the paper you are using. 

To adjust the paper type: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select Adjust Paper Type, then press OK. 
5. Select Plain or Label, then press OK. 
6. Select Lightweight or Heavyweight, then press OK. 
7. To return to the Ready screen, press Return. 
 

Adjusting the Bias Transfer Roller 

Use Adjust BTR to specify the bias transfer roller (BTR) voltage for printing on the selected paper type. If 
the printed image is too light, increase the offset for the paper you are using. If the printed image is 
mottled or blotchy-looking, decrease the offset for the paper you are using. 

To adjust the bias transfer roller: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select Adjust BTR, then press OK. 
5. Press the arrow buttons to select the paper type for the adjustment, then press OK. 
6. Press the arrow buttons to increase or decrease the amount of offset, then press OK. 
7. Repeat this procedure for each paper type you need to adjust. 
8. To return to the Ready screen, press Return. 
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Adjusting the Fuser 

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is 
smearing or can be rubbed off the paper, increase the offset for the paper you are using. If the toner is 
blistered or mottled, decrease the offset for the paper you are using. 

To adjust the fuser: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select Adjust Fusing Unit, then press OK. 
5. To select the paper type for the adjustment, use the Up or Down arrow buttons, then press OK. 
6. To increase or decrease the amount of offset, press the arrow buttons, then press OK. 
7. Repeat this procedure for each paper type you need to adjust. 
8. To return to the Ready screen, press Return. 
 

Refreshing the Bias Transfer Roller 

Use the BTR Refresh procedure to reduce paper curling and improve paper discharge. 

To refresh the bias transfer roller: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select BTR Refresh, then press OK. 
5. Select On, then press OK. 
6. To return to the Ready screen, press Return. 
 

Adjusting the Altitude 

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If 
the altitude setting is incorrect, it can cause print-quality problems. 

To adjust the altitude: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select Adjust Altitude, then press OK. 
5. Press the arrow buttons to select the altitude of the location of the printer, then press OK. 
6. To return to the Ready screen, press Return. 
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Toner Cartridges 

This section includes: 
• General Precautions ...................................................................................................................................................... 136 
• Replacing Toner Cartridges ........................................................................................................................................ 136 
• Refreshing the Toner .................................................................................................................................................... 137 
• Cleaning the Developer ............................................................................................................................................... 137 
 

General Precautions 
 

 WARNINGS: 

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid 
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the 
child spit out the toner, and rinse out their mouth with water. Consult a physician immediately. 

  

 WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. 
Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of 
toner, contact your local Xerox representative. 

  

 WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can 
catch fire and cause burn injuries or an explosion. 

  
 

Replacing Toner Cartridges 

When a toner cartridge reaches its usable life span, the control panel displays a message. PrintingScout 
displays the toner status in the Printer Status window. When a toner cartridge is empty, the printer stops 
and displays messages on the control panel and in the PrintingScout Printer Status window. 

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining 
amount displayed could be inaccurate. 

When Non-Genuine Toner is set to Off, the following messages appear on the display screen. 
 

Message Cause 

Printer Toner Cartridge is Close to Life The toner cartridge is low. 

Replace Toner Cartridge The toner cartridge is empty. 
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Refreshing the Toner 

Toner Refresh recalibrates toner concentration and developer voltages. If you print documents with high 
or low ink coverage, Toner Refresh can optimize print quality. 

To refresh the toner: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Select Toner Refresh, then press OK. 
5. To select the toner to refresh, press the arrow buttons, then press OK. 
6. Select Yes, then press OK. 

The process runs automatically. Wait three minutes for the process to complete and the printer to 
return to Ready. 

 

Note: Do not use this procedure repeatedly for a single toner color. Running the procedure 
repeatedly uses the toner supply more quickly. 

 

Cleaning the Developer 

The Clean Developer feature runs the developer motor and mixes the toner in the developer. Use the 
Clean Developer feature to refresh the toner after replacing a toner cartridge or if dark streaks are 
appearing in your prints. 

To clean the developer: 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Select Maintenance, then press OK. 
4. Navigate to Clean Developer, then press OK. 
5. Select Yes, then press OK. 

The process runs automatically. Wait three minutes for the process to complete and the printer to return 
to Ready. 
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Ordering Supplies 

This section includes: 
• Consumables ................................................................................................................................................................... 138 
• When to Order Supplies ............................................................................................................................................... 138 
• Recycling Supplies .......................................................................................................................................................... 138 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black. 
 

Notes: 

• Each consumable includes installation instructions. 
• Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner 

remaining amount displayed could be inaccurate. 
• To ensure print quality, the toner cartridge has been designed to cease functioning at a 

predetermined point. 
 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by 
Xerox for specific use with this printer. 

 
 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/WC6025supplies. 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 

 
 

Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=recyclesupplies&Language=English
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Managing the Printer 

This section includes: 
• Checking Page Counts .................................................................................................................................................. 139 
• Changing the Panel Lock Password ......................................................................................................................... 139 
 

Checking Page Counts 

You can check the total number of printed pages on the Configuration Page. The Print Volume section 
lists the total number of pages printed on each paper size. 

The Billing Meters menu shows the number of processed print jobs. There is a meter for each color mode. 
Meter readings track the total number of pages printed for the life of the printer. You cannot reset the 
meter readings. 

Note: You cannot reset the meter readings. 
 

Printing the Configuration Page 
1. On the printer control panel, press the System button. 
2. Navigate to Information Pages, then press OK. 
3. Navigate to Configuration, then press OK. 
 

Viewing the Billing Meters 
1. On the printer control panel, press the System button. 
2. Press the arrow buttons to select Billing Meters. 
3. Press OK. 
 

Changing the Panel Lock Password 

The Panel Lock password limits access to the Admin menu. 
1. On the printer control panel, press the System button. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Enter the current four-digit password, then press OK. 
4. Select Secure Settings, then press OK. 
5. At Panel Lock, press OK. 
6. Select Change Password, then press OK. 
7. Enter a new four-digit password, then press OK. The default password is 0000. 
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Moving the Printer 

Follow these instructions when moving the printer: 
1. Turn off the printer and disconnect the power cord and other cables from the back of the printer. 

  
 

 WARNING: To prevent electric shock, never touch the power plug with wet hands. When removing 
the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which 
can lead to fire or electric shock. 

 

2. Remove any paper or other media from the output tray. 

 
3. Remove the paper from the paper tray. 

Keep the paper wrapped and away from humidity and dirt. 
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4. Lift the bypass tray and push it into the printer. 

 
5. Push in the length guides and slide bar until they stop. 
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6. Close the front door. 

 
7. Lift and carry the printer as shown in the illustration. 

Note: To find the weight for your printer configuration, see Physical Specifications on page 167. 

 
 

 CAUTIONS: 

• Failure to repackage the printer properly for shipment can result in damage not 
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. 
The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover 
damage to the printer caused by improper moving. 

• When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or 
right. Tilting the printer more than 10 degrees can cause toner spillage. 

After moving the printer: 
1. Reinstall any parts you removed. 
2. Reconnect the printer to the cables and power cord. 
3. Plug in and turn on the printer. 
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This chapter includes: 
• General Troubleshooting............................................................................................................................................. 144 
• Paper Jams ....................................................................................................................................................................... 147 
• Print-Quality Problems ................................................................................................................................................. 158 
• Getting Help ..................................................................................................................................................................... 164 
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General Troubleshooting 

This section includes: 
• Printer Does Not Turn On ............................................................................................................................................ 144 
• Printer Resets or Turns Off Frequently ................................................................................................................... 144 
• Printer Does Not Print ................................................................................................................................................... 145 
• Printing Takes Too Long .............................................................................................................................................. 146 
• Printer is Making Unusual Noises ............................................................................................................................. 146 
• Condensation has Formed Inside the Printer ...................................................................................................... 146 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 

Printer Does Not Turn On 
 

Probable Causes Solutions 

The power switch is not turned on. Turn on the switch. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer power switch, and plug the power cord securely 
into the outlet. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and see if it 
operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 169. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
 
 

Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. 

A system error occurred. Turn off the printer, then turn it on again. If the error persists, 
contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Turn off the printer, then connect the power cord to a suitable 
outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other high-power devices. 
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Printer Does Not Print 
 

Probable Causes Solutions 

The printer is in Energy Saver mode. Push the control panel button. 

The printer has an error. Follow the instructions on the control panel to clear the error. If the 
error persists, contact your Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

The Error Indicator is blinking. If the Ready Indicator is off, the printer has stopped working. Turn 
off the printer, then turn it on again. If the error persists, contact 
your Xerox representative. 

Both control panel indicators are off. Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. If 
the error persists, contact your Xerox representative. 

The printer is busy. • If the Ready Indicator is flashing, it is normal. A previous print 
job could be the problem. Use the printer properties to delete all 
print jobs in the print queue. 

• Load the paper in the tray. 
• If the Ready Indicator is not flashing after you send a print job, 

check the USB connection between the printer and the 
computer. Turn off the printer, then turn it on again. 

The printer cable is disconnected. • If the Ready Indicator is not flashing after you send a print job, 
check the USB connection between the printer and the 
computer. 

• If the Ready Indicator is not flashing after you send a print job, 
check the Ethernet connection between the printer and the 
computer. 
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Printing Takes Too Long 
  

Probable Causes Solutions 

The printer is set to a slower printing mode. 
For example, the printer could be set to print 
on Heavyweight paper. 

It takes more time to print on certain types of special paper. Ensure 
that the paper type is set properly in the driver and at the printer 
control panel. 

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out of 
Power Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, 
print an information page from the control panel. If the page does 
not print at the rated speed of the printer, there could be a network 
or printer installation issue. Contact the system administrator. 

The job is complex. Wait. No action needed. 
 
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox representative. 

 
 

Condensation has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. Allow the printer to operate for several hours at room temperature. 

The relative humidity of the room is too high. • Reduce the humidity in the room. 
• Move the printer to a location where the temperature and 

relative humidity are within the operating specifications. 
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Paper Jams 

This section includes: 
• Minimizing Paper Jams ................................................................................................................................................ 147 
• Locating Paper Jams ..................................................................................................................................................... 149 
• Clearing Paper Jams...................................................................................................................................................... 150 
• Troubleshooting Paper Jams ..................................................................................................................................... 156 
 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, see Supported Paper on page 68. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 
• After loading the trays, select the correct paper type and size on the control panel. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 
• Use only Xerox paper and transparencies designed for the printer. 
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Avoid the following: 
• Polyester coated paper that is specially designed for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the trays. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, go to www.xerox.com/rmlna. 
 

http://www.xerox.com/printer-supplies/recommended-paper/enus.html
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Locating Paper Jams 
 

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If 
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off 
the printer immediately and wait 20 minutes for the fuser to cool. Try to remove the jam after the 
printer has cooled. If the error persists, contact your Xerox representative. 

 

 CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently 
damage the printer. 

 

The following illustration shows where paper jams occur along the paper path and the printer parts used 
for clearing paper jams. 

 
1. Output Tray 
2. Transfer Belt 
3. Release Levers 
4. Rear Door 
5. Front Door 
6. Main Tray 
7. Bypass Tray 
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Clearing Paper Jams 

This section includes: 
• Clearing Paper Jams From the Front of the Printer .......................................................................................... 150 
• Clearing Paper Jams From the Back of the Printer ............................................................................................ 151 
• Clearing Paper Jams From the Output Tray ........................................................................................................ 153 

To facilitate clearing paper jams, you can activate Jam Recovery Mode. Jam Recovery Mode runs the 
printer for a brief period of time to move the paper further into the exit tray. 

To run Jam Recovery Mode: 
1. Press and hold the Clear All button for three seconds. 
2. After the printer engine stops running, turn the power off, then remove the jammed paper. 
 

Clearing Paper Jams From the Front of the Printer 
1. Remove any paper from the bypass tray. 
2. Remove the bypass tray. 

 
3. Remove any paper jammed at the front of the printer. 
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4. Place the bypass tray on the main tray, then align the tabs with the marks. 

  
5. Follow the instructions on the control panel display and in the Printer Status window of 

PrintingScout. 
6. Press OK. 
7. To resolve the error displayed on the control panel you must clear all paper from the paper path. 
 

Clearing Paper Jams From the Back of the Printer 
1. Push down on the rear door release and pull open the door. 

 
2. Lift the levers as shown. 
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3. Remove any jammed paper from the back of the printer. 

 
4. Lower the levers to their original position. 

 
5. Close the rear door. 

 
6. Follow the instructions on the control panel display and in the Printer Status window of 

PrintingScout. 
7. Press OK. 
8. To resolve the error displayed on the control panel you must clear all paper from the paper path. 
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Clearing Paper Jams From the Output Tray 
1. Push down on the rear door release and pull open the door. 

 
2. Lift the levers as shown. 

 
3. Remove any jammed paper from the back of the printer. 

 
4. Lift and open the scanner. 
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5. Remove any paper or other media from the output tray. 

 
6. Lower the scanner and close it. 

 
7. Lower the levers to their original position. 

 
8. Close the rear door. 
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9. Follow the instructions on the control panel display and in the Printer Status window of 
PrintingScout. 

10. Press OK. 
11. To resolve the error displayed on the control panel you must clear all paper from the paper path. 
 



Troubleshooting 

 

156 Xerox® WorkCentre® 6025 Multifunction Printer 
 User Guide 
 

Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 156 
• Paper Misfeeds ................................................................................................................................................................ 156 
• Label and Envelope Misfeeds .................................................................................................................................... 157 
• Paper Jam Message Stays On ................................................................................................................................... 157 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present. • Try a new ream of paper. 
• Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox approved paper. For details, see Supported Paper on 
page 68. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the tray. 
• Adjust the paper guides in the tray to match the size of the 

paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, 
do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox approved paper. For details, see Supported Paper on 
page 68. 

  
 



Troubleshooting 

 

 Xerox® WorkCentre® 6025 Multifunction Printer 157 
 User Guide 
 

Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

• Load label sheets according to the instructions from the 
manufacturer. Load labels face up in either tray. 

Envelopes are loaded incorrectly. • Load No. 10, DL, and Monarch envelopes in the trays with the 
print side up, flaps closed, flap-side down, and the short edge 
leading into the printer. 

• Load C5 envelopes with the print side up, flaps open and facing 
away from the printer. 

No. 10, DL, and Monarch envelopes are 
wrinkling. 

To prevent wrinkling on No. 10, DL, C5, or Monarch envelopes, load 
them print side up, flaps open and facing away from the printer. 
 

Note: When you load envelopes long-edge feed, ensure that you 
specify landscape orientation in the print driver. 

  
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and ensure that you have removed all of 
the jammed paper. 
Check for, and remove, torn pieces of paper in the paper path. 

One of the printer doors is open. Check the doors on the printer and close any door that is open. 

The rear door interlock switch is not reset. To reset the interlock switch and clear the paper jam message, open 
and close the back door. 
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Print-Quality Problems 

This section includes: 
• Controlling Print Quality .............................................................................................................................................. 159 
• Solving Print-Quality Problems .................................................................................................................................. 160 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC6025support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 

Notes: 

• To ensure consistent print quality, the toner cartridges and imaging units for many models of 
equipment are designed to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
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Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper and toner designed for your printer, and correctly set the Paper Type, Print-Quality 
Mode, and Color Adjustments. To maintain optimum print quality from your printer, follow the 
guidelines in this section. 

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal 
quality is 15–28°C (59–82°F) and 20–70% relative humidity. 
 

Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox approved paper. For details, see Supported Paper on page 68. 
• Use only dry, undamaged paper. 
 

 CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, 
or damage your printer. Do not use the following: 

• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 

  

• Ensure the paper type selected in your print driver matches the paper type on which you are 
printing. 

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is 
selected in the print driver. 

• Store your paper and other media properly for optimum print quality. For details, see Paper Storage 
Guidelines on page 69. 
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Solving Print-Quality Problems 

When the print quality is poor, select the closest symptom from the following table and see the 
corresponding solution to correct the problem. You can also print a Demo Page to more precisely 
determine the print-quality problem. For details, see Information Pages on page 24. 

If the print quality does not improve after carrying out the appropriate action, contact your Xerox 
representative. 
 

Notes: 

• To enhance print quality, toner cartridges for many models of equipment have been designed to 
cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

 

Symptom Cause Solution 

Faded printouts with multiple 
colors faded 

 

 

The paper type is heavier or 
thicker than the paper type 
selection. 

Adjust the paper type settings. For 
details, see Adjusting Paper Type on 
page 134. 

The paper being used is outside 
the recommended specification 
range. 

Replace the paper with a recommended 
size and type, and confirm that your 
control panel and print driver settings are 
correct. For details, see Supported Paper 
on page 68. 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. It can 
take several prints before full quality is 
restored. 

 

The bias transfer roller voltage is 
insufficient for the paper type. 

Increase the bias transfer voltage for the 
selected paper type. For details, see 
Adjusting the Bias Transfer Roller on 
page 134. 

The fuser is not adjusted for the 
paper type. 

Adjust the fuser. For details, see 
Adjusting the Fuser on page 135. 

The paper is damp. Replace the paper. 

 

The high-voltage supply is 
defective. 

For assistance, go to the Xerox® Support 
website at 
www.xerox.com/office/WC6025support. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
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Symptom Cause Solution 

Only one color is faded 

 

Toner cartridge is empty or 
damaged. 

Check the condition of the toner 
cartridge and replace it if necessary. 

Stray black dots, white areas, or 
dropouts 

 

The paper is outside the 
recommended specification 
range. 

Replace the paper with a recommended 
size and type, and confirm that your 
control panel and print driver settings are 
correct. For details, see Supported Paper 
on page 68. 

 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 138. 

• Vertical black or color streaks 
or multiple colored streaks or 
lines 

• Streaks in one color only 

 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 138. 

 

There is a problem with the 
toner cartridge for that color. 

Check the condition of the toner 
cartridge and replace it if necessary. For 
assistance, go to the Xerox® Support 
website at 
www.xerox.com/office/WC6025support. 

Color around the edge of 
printing is incorrect 

The color registration is 
incorrect. 

Adjust the color registration. For details, 
see Color Registration on page 133. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
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Symptom Cause Solution 

Partial blanks, creased paper, or 
blotted printing 

 

The paper is damp. Replace the paper. 

The paper is outside the 
recommended specification 
range. 

Replace the paper with a recommended 
size and type, and confirm that your 
control panel and print driver settings are 
correct. For details, see Supported Paper 
on page 68. 

The printer is worn or damaged. For assistance, go to the Xerox® Support 
website at 
www.xerox.com/office/WC6025support. 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 138. 

The altitude setting is incorrect. Adjust the altitude setting of the printer. 
For details, see Adjusting the Altitude on 
page 135. 

Condensation inside the printer 
causes partial blanks or creased 
paper. 

Turn on the printer and leave it on for at 
least one hour remove the condensation. 
For assistance, go to the Xerox® Support 
website at 
www.xerox.com/office/WC6025support. 

Vertical blanks 

 

The lenses are being blocked. Clean the lenses inside of the printer. For 
details, see Cleaning the LED Lenses on 
page 129. 

The printer is worn or damaged. For assistance, go to the Xerox® Support 
website at 
www.xerox.com/office/WC6025support. 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 138. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
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Symptom Cause Solution 

Slanted printing 

 

The paper guides are not 
correctly adjusted to the paper 
size. 

Reset the paper tray guides. For details, 
see Loading Paper on page 71. 

Colors are blurry or there is white 
area around objects 

Color-to-color alignment is not 
correct. 

Perform an automatic color registration 
adjustment. For details, see Color 
Registration on page 133. 

Blotchy or mottled images 

 
 

The paper is too light or too thin. Choose a different paper type at the 
control panel, in the application, and in 
the print driver. 

The bias transfer roller voltage is 
insufficient for the paper type. 

Increase the bias transfer voltage for the 
selected paper type. For details, see 
Adjusting the Bias Transfer Roller on 
page 134. 

The fuser is not adjusted for the 
paper type. 

Adjust the fuser. For details, see 
Adjusting the Fuser on page 135. 

The paper is damp. Replace the paper. 

The relative humidity of the 
room is too high. 

Reduce the humidity in the room or move 
the printer to a new location. 

Paper curls or frequent jams in 
the rear cover 

The bias transfer roller needs to 
be refreshed. 

Refresh the bias transfer roller. For 
details, see Refreshing the Bias Transfer 
Roller on page 135. 
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Getting Help 

This section includes: 
• Error and Status Messages ......................................................................................................................................... 164 
• PrintingScout Alerts ....................................................................................................................................................... 164 
• Online Support Assistant ............................................................................................................................................. 164 

Your printer comes with utilities and resources to help you troubleshoot printing problems. 
 

Error and Status Messages 

The printer control panel provides information and troubleshooting help. When an error or warning 
condition occurs, the control panel informs you of the problem. Error messages warn you about printer 
conditions, such as low supplies or doors open, that require your attention. 
 

PrintingScout Alerts 

PrintingScout is a utility installed with your Xerox® print driver. It automatically checks the printer status 
when you send a print job. If the printer is unable to print, a PrintingScout alert appears on your 
computer screen to let you know that the printer needs attention. In the PrintingScout dialog box, click 
the alert to view instructions explaining how to fix the problem. 
 

Note: PrintingScout is a Windows-only application. 
 
 

Online Support Assistant 

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/WC6025support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6025&PgName=tech&Language=English
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Standard Features 
 

Functions Copy, scan, and print 

Print speed • Up to 12 ppm black and white 
• Up to 10 ppm color 

Copy speed • Up to 12 cpm black and white 
• Up to 2.5 cpm color 

Print resolution 600 x 600 dpi from the print driver prints at 1200 x 2400 dpi enhanced 

Paper Capacity 100 sheets of standard paper in the output tray 
Main Tray 
• 150 sheets of standard paper 
• One sheet of coated paper 
• Five envelopes 
Bypass Tray 
• 10 sheets of standard paper 
• One sheet of coated paper 
• One envelope 

2-Sided Printing Manual 

Maximum copy size 216 x 297 mm (8.5 x 11.6 in.) 

Maximum print size Legal (216 x 356 mm, 8.5 x 14 in.) 

Automatic Document 
Feeder 

None 

Control panel Button-navigated menu with four-line display 

Connectivity • Universal Serial Bus (USB 2.0) 
• Wireless network adapter 

Scan functions • Scan to USB Memory 
• Scan to Computer 

Scan resolution 1200 x 1200 dpi 

Remote access CentreWare Internet Services 
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Physical Specifications 

Dimensions and Weight 
 

Width 410 mm (16.1 in.) 

Depth 389 mm (15.3 in.) 

Height 318 mm (12.5 in.) 

Weight 15 kg (33.1 lb.) 
 
 

Total Space Requirements 
 

Width 848 mm (33.4 in.) 

Depth 937 mm (36.9 in.) 

Height 691 mm (27.2 in.) 
 
 

Clearance Requirements 
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Environmental Specifications 

Temperature 
• Operating temperature: 10–32°C (50–90°F) 
• Optimum temperature: 15–28°C (59–82°F) 
 

Relative Humidity 
• Minimum–Maximum Humidity Range: 15–85% relative humidity at 28°C (82°F) 
• Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F) 
 

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, defects 
can occur due to condensation. 

 
 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft). 
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Electrical Specifications 

Power Supply Voltage and Frequency 
 

Power Supply Voltage Power Supply Frequency 

110–127 VAC +/-10%, (99–140 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

220–240 VAC +/-10%, (198–264 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

 
 

Power Consumption 
 

Printer Mode Power Consumption 

Power Saver Mode 1 (Low Power) 11 W or less 

Power Saver Mode 2 (Sleep) 3 W or less 

Ready/Standby 55 W or less 

Continuous printing 320 W or less 
 

Note: This printer does not consume electric power when the power switch is turned off even if the 
printer is connected to an AC outlet. 

 

ENERGY STAR Qualified Product 
 
 
 
 

 

This product is ENERGY STAR® qualified under the ENERGY STAR Program 
Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United 
States, European Union, and Japanese governments and the office equipment industry 
to promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes 
after 2 minutes from the last copy or print. 
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Performance Specifications 
 

Printer warm up time Power on: 32 seconds or less. 
Recovery from sleep mode: 32 seconds or less. 

 

Note: Warm up time assumes an ambient temperature of 22°C (71.6°F). 
 



Specifications 

 

 Xerox® WorkCentre® 6025 Multifunction Printer 171 
 User Guide 
 

Controller Specifications 

Processor 

525 MHz ARM11MP 
 

Memory 

256 MB RAM 
 

Interfaces 
• Universal Serial Bus (USB 2.0) 
• Wireless network connectivity 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance 
with these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
 



Regulatory Information 

 

 Xerox® WorkCentre® 6025 Multifunction Printer 175 
 User Guide 
 

European Union 
 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 
• December 12, 2006: Low Voltage Directive 2006/95/EC 
• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Introduction 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
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Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

ENERGY STAR 

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy 
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and 
models qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ 

For additional information on energy or other related topics, please see 
www.xerox.com/about-xerox/environment/enus.html or 
www.xerox.co.uk/about-xerox/environment/engb.html. 
 

Power Consumption and Activation Time 

The amount of electricity that a product consumes depends on the way the device is used. This product 
is designed and configured to enable you to reduce your electricity usage. 

After the last print, the device switches to Ready mode. In this mode, the device can print again 
immediately. If the product is not used for a period of time, the device switches to a Power Saver mode. 
In these modes, to enable reduced product power consumption, only essential functions remain active. 
The product takes slightly longer to produce the first print after it exits Power Saver mode than it takes in 
Ready mode. This delay is the result of the system waking up from Power Saver mode and is typical of 
most imaging products on the market. 

You can set a longer activation time or completely deactivate the Power Saver mode. This device can 
take longer to switch to a lower energy level. 

Note: Changing the default Power Saver activation times can result in an overall higher energy 
consumption of the product. 

To learn more about Xerox participation in sustainability initiatives, go to: 
www.xerox.com/about-xerox/environment/enus.html. 
 

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
http://www.xerox.com/about-xerox/environment/enus.html
http://www.xerox.co.uk/about-xerox/environment/engb.html
http://www.xerox.com/about-xerox/environment/enus.html
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Environmental Choice Certified to Office Machines CCD-035 
 
 
 

 

This product is certified to Environmental Choice standard for office machines, meeting 
all requirements for reduced environmental impact. As part of achieving certification, 
Xerox Corporation has proven this product meets the Environmental Choice criteria for 
energy efficiency. Certified copier, printer, multifunctional device, and fax products 
must also meet criteria such as reduced chemical emissions and demonstrate 
compatibility with recycled supplies. Environmental Choice was established in 1988 to 
help consumers find products and services with reduced environmental impacts. 
Environmental Choice is a voluntary, multi-attribute, and lifecycle-based environmental 
certification. This certification indicates that a product has undergone rigorous 
scientific testing, exhaustive auditing, or both, to prove its compliance with stringent, 
third-party, environmental performance standards. 

 
 

Germany 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
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Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
1. Obligations or Securities of the United States Government, such as: 

− Certificates of Indebtedness. 
− National Bank Currency. 
− Coupons from Bonds. 
− Federal Reserve Bank Notes. 
− Silver Certificates. 
− Gold Certificates. 
− United States Bonds. 
− Treasury Notes. 
− Federal Reserve Notes. 
− Fractional Notes. 
− Certificates of Deposit. 
− Paper Money. 
− Bonds and Obligations of certain agencies of the government, such as FHA and so on. 
− Bonds. United States Savings Bonds may be photographed only for publicity purposes in 

connection with the campaign for the sale of such bonds. 
− Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 

canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

− Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

− Postal Money Orders. 
− Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 
− Stamps and other representatives of value, of whatever denomination, which have been or 

may be issued under any Act of Congress. 
− Adjusted Compensation Certificates for Veterans of the World Wars. 

2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 
6. Immigration papers. 
7. Draft Registration Cards. 
8. Selective Service Induction papers that bear any of the following Registrant’s information: 

− Earnings or Income. 
− Court Record. 
− Physical or mental condition. 
− Dependency Status. 
− Previous military service. 
− Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 
• Automobile Licenses. 
• Drivers’ Licenses. 
• Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
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Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
• Current bank notes or current paper money 
• Obligations or securities of a government or bank 
• Exchequer bill paper or revenue paper 
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of 

a court of law 
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 

same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer 
for a province) 

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 

• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of 
a province or by the government of a state other than Canada 

• Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 
• Currency notes 
• Bank notes and checks 
• Bank and government bonds and securities 
• Passports and identification cards 
• Copyright material or trademarks without the consent of the owner 
• Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds 
• European Union: www.xerox.com/environment_europe 

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=msdsna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=environmenteu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=customersupport&Language=English
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6025&PgName=environmentna&Language=English
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents 
mean that used electrical and electronic products and batteries should 
not be mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 
2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items. 

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a manufacturer-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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